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1. CURRENT CHANGES 
This section describes current changes to the Endicia XML interface. For information about changes to previous releases, 
see the Change History.  

Summary of Changes 

# Description of Change Change Type 
Implementation 

Impact 
1 Modified <TransactionID> possible content Output Data Mandatory 
2 Added <PrintID> tag Output Data Optional 

 
Mandatory: Affects all or most Endicia XML integrations. 
Optional: Affects integrations using optional features. 
Informational: For information only; usually no action is required. 
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2. OVERVIEW 
This Overview describes: 

 About the XML Client Interface for DAZzle 
 Standards 
 Platform Differences 
 Actions Supported 
 Pass XML Data into DAZzle  
 DAZzle Root XML Tag Options 

About the XML Client Interface for DAZzle 
Endicia (a Stamps.com, Inc. company) supports a variety of XML-based interfaces that can greatly enhance the 
communication between DAZzle and other applications or systems. The Endicia XML Client Interface allows other 
applications to supply or retrieve information from Endicia, our postage printing service, using industry standard 
protocol. Also, a limited number of automation capabilities using the XML interface can streamline the interface process. 
 
DAZzle provides compliance to postal rules and may reject some transactions that are not valid. Other transactions that 
use tags that are not applicable to the shipment being processed may be ignored, sometimes without warning.  
 
Refer to the Current Changes section of this document for a list of changes.  
 
Although there are already many powerful features, the XML interface is evolving to increase its functionality and 
breadth of information supported. Due to XML’s flexibility, this should not cause backwards compatibility issues with 
early adopters of the interface, but there is no guarantee that new versions of DAZzle may not require some 
modifications to existing systems. 
 
If you are using the XML interface as part of a product that will be distributed to customers, Endicia considers you to be 
an integrated partner. Please send by email the following information to partnermgmt@stamps.com. After we have 
received your information, a representative of Endicia will contact you and provide information and benefits of joining 
our Integrated Partner Program. At that time, we will assign you a Partner ID *. 
 

 Name of the product and company supporting the Endicia XML Client Interface. 
 Contact information (email address and phone number) that our customers can use. 
 Technical contact information (email address and phone number) for Endicia technicians or developers.  
 Types of interface support, for example, command line, directory monitoring, or Clipboard, and so on.  
 Platforms supported (Windows, Mac).  
 Any instructions you give your customers or screenshots of the interface. 

 
*Your Partner ID must be included with all XML transactions to participate in Endicia’s Integrated Partner Program. 

Standards 
DAZzle supports various different XML interfaces for different functions, and thus there are some differences in the 
syntax for each case. When similar information is shared between different functions, the XML is consistently named 
and used, but not all interfaces support the same feature set. Each of the interfaces described in this document details 
the supported tags and proper usage. 

Actions Supported 
XML-formatted data can be used in a number of different ways within the client applications: 
 

 Printing: DAZzle can print one or many addresses from an XML file. For more information, see the Printing 
section. 



 

CONFIDENTIAL Endicia Page 6 

 Verifying Addresses: DAZzle can verify (and update) address information in an XML file. For more information, 
see the Address Verification section.  

 Importing into the Address Book: Addresses can be loaded into the current DAZzle address book through XML. 
For more information, see the Address Book section.  

 Exporting Data from the Postage Log: Data from the DAZzle Postage Log can be copied to an XML-formatted file 
for transfer to other applications. For more information, see Postage Log section. 

Pass XML Data into DAZzle   
The first three methods listed below use a standard Windows text file that contains XML-formatted data (as specified in 
the following sections). These XML-based files must use the extension “XML” for proper recognition and usage, for 
example packagedata.xml. 
 
Printing, verifying, and importing addresses into the Address Book require XML files as inputs to DAZzle in order to work. 
Exporting data from the Postage Log creates an XML file as output to the menu item selected in DAZzle.  

Interactively Using the DAZzle Menu 
Through menus in DAZzle, you can interactively invoke each of the following actions using XML data: 
 

 Print an XML-Formatted File 
 Verify Addresses in an XML-formatted File  
 Import Addresses into the Address Book 
 Export Data from the Postage Log 

 

Print an XML-Formatted File 
The following step describes how to begin the process of printing an XML-formatted file. 
 
Step 
 

 From the Design tab in DAZzle, select File > Print from > External File….  
For more information, see the Printing section. 

 

Verify Addresses in an XML-formatted File 
The following step describes how to verify addresses in an XML-formatted file. 
 
Step 
 

 From the Design tab in DAZzle, select Layout > Dial-A-ZIP from > External File…. 
For more information, see the Address Verification section. 

 

Import Addresses into the Address Book 
The following step describes how to import addresses into the Address Book. 
 
Step 
 

 From the Address Book tab in DAZzle, select File > Import…, and then select an XML file.  
For more information, see the Address Book section. 
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Export Postage Log Data  
The following steps describe how to export Postage Log data. 
 
Steps 
 

1. From the Postage Log tab, select File > Export…. 
2. Enter a starting date and an ending date.  
3. Click the Export button.  
4. In the Select Export File window: 

a. Enter the name of an XML file to create. 
b. In the “Save as type” field, select Text, XML format.  

5. Click Save. 
For more information, see the Postage Log section. 
 

Using the Command Line 
DAZzle operations can be automated by launching DAZzle with an XML file in the command line interface. The specified 
XML file should include the optional “DAZzle” attributes to signal DAZzle which method to invoke (and any desired 
options for that method).  
 
For example, the following command causes DAZzle to: 

 Automatically load the file “c:\lists\listfile.xml” when DAZzle is launched. 
 Follow any specified commands within the XML file. 

 
Dazzle.exe c:\lists\listfile.xml 

 
If no automation command is within the XML file, DAZzle takes no action.  
 
Refer to the method details for the attributes appropriate to that method. Also note that no other command line option 
can be used when specifying an XML file (the XML format provides for invoking other options). 
 

Using Directory Monitoring 
DAZzle monitors the directory “<dazzle>\xml” where <dazzle> is the directory containing the DAZzle executable for any 
XML files. When an XML file is found in this directory, the XML file is automatically opened and printed according to all 
applicable tag commands. This feature can be used to automate DAZzle from other programs that produce XML output 
but have trouble launching DAZzle. Every 30 seconds DAZzle automatically checks the specified directory for any XML 
files. DAZzle prints the first XML file it finds, performing the print as if a user had selected it. When DAZzle is finished 
printing, the file is renamed with a “.BAK” extension so that the file is not processed repeatedly.  
 
When using the directory monitoring option, the XML file must include the OutputFile option of the DAZzle tag, and that 
filename must use a different directory than the source directory or it will repeatedly process the file. For automation 
option information, see the DAZzle Printing XML Syntax section. 
 

Using the Clipboard 
The Clipboard can be used to transfer data to DAZzle for both the printing and address verification actions. The data 
should be formatted exactly the same as if these actions were performed using a file.  
If any DAZzle tag options are specified in the XML data, for example Start=”PRINTING” or Prompt=“NO”, DAZzle will 
respond accordingly with the exception of the AutoClose option. 
 
The following topics summarize the methods of retrieving data from the Clipboard: 
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 Manually Retrieve Clipboard Data 
 Obtain Address Verification of the XML Data 
 Automatically Monitor Clipboard Data 

 

Manually Retrieve Clipboard Data 
The following step describes how to examine the Clipboard for XML-formatted data (one or more addresses may be in 
the XML data). 
 
Step 
 

 From the Design tab in DAZzle, select Edit > Paste Address.  
 

Obtain Address Verification of the XML Data 
The following step describes how to obtain address verification of the XML data. 
 
Step 
 

 From the Design tab, select Layout > Dial-A-ZIP from > Clipboard…. 
 

Automatically Monitor Clipboard Data 
The following steps describe how to have DAZzle constantly monitor the Clipboard for data and immediately act upon 
any properly formatted XML data found. 
 
Steps 
 

1. From either the Design tab or the Address Book tab in DAZzle, select File > Preferences…. 
2. On the Clipboard tab, select the Monitor Clipboard for addresses option  
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3. DAZZLE ROOT XML TAG OPTIONS 
 
You can automate the processing of XML files and reduce the number of prompts to the user who is using the Endicia 
XML root tag options. The word “DAZzle” must always be the root element (the “header” tag) in the file and can use the 
options described below. 
 

Note : All DAZzle element attributes are ignored when invoking printing from the menu (that is, by selecting File 
> Print from > External File…) because all options are set interactively.  

 
The following topics describe the root-level tag options: 
 

 Change Layouts–Layout  
 Turn Off Alert Dialogs and Prompts–Prompt 
 Abort Process When Prompts Are Disabled–AbortOnError 
 Print Test Labels–Test 
 Automatically Invoke DAZzle Options–Start 
 Specify the Output File Name–OutputFile 
 Skip Addresses That Do Not Verify–SkipUnverified 
 Automatically Close DAZzle when Done–AutoClose 

 

Change Layouts—Layout  

Setting the Layout value to the fully qualified path name of a DAZzle layout file causes DAZzle to change to that layout 
prior to printing. This change only occurs one time per file (for example, you cannot change layouts in the middle of 
printing).  
 
The following table shows some recommended layout selections based on printer and shipment type. Please note that 
each shipment may have special qualities thad may need a different layout.  

Table 3—1: Recommended Layouts Based on Printer and Shipment Type 

Description 
Layout Suggestion Based on Printer Type 

Thermal – 4” label Laser or Inkjet 
Domestic Priority Mail package or flat 
rate product 

Dymo4XL Label.lyt Priority Mail Shipping Label.lyt 

Domestic Priority Mail Express package or 
flat rate product 

Dymo4XL Express Mail Shipping 
Label.lyt 

Express Mail Shipping Label.lyt 

First-Class Letter n/a Envelope.LYT 
APO/FPO or US territory shipment APO and US Territory Label – Small 

6x4.lyt 
APO and US Territory Label – 
Large.lyt 

International shipment International Label – Small 6x4.lyt International Label – Large.lyt 
 

Note: The Change Layouts–Layout option does not apply to the address verification process. 
 

Turn Off Alert Dialogs and Prompts—Prompt 

Setting the Prompt value to “NO” causes the client application to suppress all option and information windows (for 
example, the “Don’t remind me again” dialog windows) so that printing is fully automated. Error messages may continue 
to appear.  
 

Note: The Turn Off Alert Dialogs and Prompts–Prompt option does not apply to the address verification process. 
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For information about error handling, see the AbortOnError option, which follows. The default value for this attribute is 
“YES”.  
 

Important! If the Prompt=“YES” option is selected, the user cannot override any value specified in the XML file. 
Thus, do NOT include data values for items that the user should enter or select. 
 

Abort Process When Prompts Are Disabled—AbortOnError  

If the Prompt value is “YES” or AbortOnError value is “NO”, DAZzle prompts the user to respond should an error occur 
that causes either the Tracking Number process or Endicia Postage process to fail. The user must then choose to 
continue despite the error or may abort the list printing. If AbortOnError is set to “YES”, all error messages are 
suppressed and DAZzle automatically aborts the list process if an error occurs. The default value for this attribute is 
“NO”. 
 

Note: The Abort Process When Prompts Are Disabled–AbortOnError option does not apply to the address 
verification process. 
 

Print Test Labels—Test 

Setting the Test value to “YES” causes DAZzle to print a sample indicia on each piece in the mailing and NOT use actual 
postage. This attribute can be useful to make test runs to make sure the printing and data are all correct before using 
actual postage. If this attribute is not specified, real postage will be used. If you have also selected the Prompt=“YES” 
option, then this feature has no effect because the user can select Test Print or Print. 
 

Note: The Print Test Labels–Test option does not apply to the address verification process. 
 

Automatically Invoke DAZzle Options—Start 

DAZzle actions can be automatically invoked using the Start attribute of the DAZzle tag.  
 Set Start=”PRINTING” to start the printing of the XML data. 
 Set Start=”DAZ” to start the address verification process on the XML data. This option ONLY applies when 

using the Command Line launch method. For more information, see Using the Command Line . 
 

Important! The following options do not apply to the address verification process. 
 

Specify the Output File Name—OutputFile 

When the Prompt value is “YES” (which is the default value), DAZzle prompts the user for the output file name. You can 
bypass the prompt and specify the output file name by using the OutputFile attribute. (For more information, see 
Output Information in the Printing section.) If no output file name is specified and the Prompt value is set to “NO”, the 
output file is automatically named “filename-output.xml”.  
 
Note: The Specify the Output File Name–OutputFile option does not apply to the address verification process. 
 

Skip Addresses That Do Not Verify—SkipUnverified  

Normally, DAZzle prints every address on a list, even if the address cannot be verified. When an address is not verified, 
no postage is printed with the unverified address. To skip the unverified addresses during printing, set the 
SkipUnverified value to “YES”. 
 
Note: The Skip Addresses That Do Not Verify–SkipUnverified option does not apply to the address verification process.  
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Automatically Close DAZzle When Done—AutoClose  

Setting the AutoClose value to “YES” causes DAZzle to automatically close when the printing of the addresses in the file 
is complete. The default value for this attribute is “NO”.  
 

Note: The Specify the Output File Name–OutputFile option does not apply: 
 To the address verification process. 
 When printing from the Clipboard. 
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4. PRINTING 
Printing of a single item or a list of items can be accomplished with appropriately formatted XML data (using either a file 
or the Clipboard).  
 
Topics in this section include: 
 

 Client Printing XML Syntax 
 

Client Printing XMLSyntax  

The Client Printing XML tags are described in detail in the XML Printing Elements table.  
 
Important! The following important notes apply to all elements in the following table: 
 

 Omitting any value causes the client application to use the last used or default value for that element (or in the 
case of a list, the value for the previous item). This is especially important to consider for options that impact the 
rate paid (for example, insurance). If you turn ON an item for a single piece you MUST turn it OFF for the next 
item or it will stay ON! 

 Default values for Boolean tags are FALSE, NO, or OFF unless otherwise stated in the description. 
 Some elements may not be applicable for the type of shipment selected, in which case these elements be 

ignored. 
 Italic items are optional.  
 Bold elements are updated (or added if missing) when creating the output file or data. 

Table 4—1: XML Client Printing Elements 

Element Type Size or Values Description 
DAZzle Root n/a The root node for the XML request. 
 Layout 

 
attribute Filename The fully qualified path name of a DAZzle 

layout file. The attribute does NOT apply when 
started by selecting File > Print From External 
File from the Design tab. 

Prompt 
 

attribute YES 
 
NO 

A value of NO causes DAZzle to suppress all 
printing windows and information boxes. This 
option does NOT apply when Start=“DAZ”. 

AbortOnError 
 

attribute YES 
 
NO 

A value of YES causes DAZzle to stop the list 
processing when an error is encountered AND 
the Prompt attribute is “NO”. 

Test attribute YES 
 
NO 

A value of YES forces sample postage for 
testing purposes. This option does NOT apply 
when Prompt=”YES” (user clicks the Test Print 
button from the Print dialog box instead). 

Start 
 

attribute PRINTING 
 
DAZ 

A value of PRINTING causes DAZzle to 
automatically start printing.  
A value of DAZ starts the address verification 
process. 

OutputFile attribute Filename The fully qualified path name of a file for the 
output results of a printing request. 

SkipUnverified 
 

attribute YES 
 
NO 

A value of YES causes DAZzle to omit 
addresses that cannot be verified.  
A value of NO will force all addresses to be 
printed, but if the address cannot be verified, 
no postage will be printed with that address. 
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Element Type Size or Values Description 
AutoClose 
 

attribute YES 
 
NO 

A value of YES causes DAZzle to automatically 
close at the end of printing. This attribute 
does NOT apply when Start=”DAZ”. 

AutoPrintCustomsForms 
 

attribute YES 
 
NO 

A value of YES causes DAZzle to print any 
requested customs form to the default 
Windows printer. 
 (Deprecated. Was removed from XML in the 
April 2016 version) 

PartnerID attribute 4 digit alphanumeric Specify the Partner ID assigned by Endicia. This 
is required for partners. Non-partners should 
ignore this element. 

Package Node n/a Package information. 
 ID Numeric 

attribute 
1-n Specify the numeric identifier for each package 

in the request. There may be multiple package 
(indicium) requests. 

MailClass Text NONE 
 
FIRST 
 
PRIORITY 
 
PRIORITYEXPRESS 
 
EXPRESS 
 
PARCELSELECT 
 
STANDARDPOST 
 
 
MEDIAMAIL 
 
LIBRARYMAIL 
 
BOUNDPRINTEDMATTER 
 
PRESORTEDSTANDARD 
 
RETAILGROUND 
 
INTLFIRST 
 
INTLPRIORITY 
 
INTLPRIORITYEXPRESS 
 
INTLEXPRESS 

Do not print postage 
 
First-Class Mail® or First-Class Package Service 
 
Priority Mail® 
 
Priority Mail Express™ (formerly Express 
Mail®) 
Express Mail® (Deprecated. Was removed 
from XML in the April 2016 version) 
Parcel Select Ground® 
 
Standard Post (formerly Parcel Post) 
(Deprecated. Was removed from XML in the 
January 2017 version) 
Media Mail® 
 
Library Mail 
 
Bound Printed Matter  
 
Presorted, Standard Mail 
 
Retail Ground® 
 
First-Class Mail International® or First-Class 
Package International Service™ 
Priority Mail International® 
 
Priority Mail Express International™ (formerly 
Express Mail International®) 
Express Mail International® (Deprecated. Was 
removed from XML in the April 2016 version) 

DateAdvance numeric 0-7 Specify the number of days to advance date 
the indicium. The maximum value is 7 days. 

PackageType Text POSTCARD 
 
ENVELOPE 
 
FLAT 
 
RECTPARCEL 

First-Class Mail Postcard  
 
First-Class Mail Letter 
 
First-Class Mail Large Envelope 
 
Rectangular Parcel–the standard parcel 
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Element Type Size or Values Description 
 
NONRECTPARCEL 
 
FLATRATEENVELOPE 
 
FLATRATEBOX 
 
 
 
FLATRATEMEDIUMBOX  
 
FLATRATELARGEBOX  
 
FLATRATESMALLBOX 
 
FLATRATEPADDEDENVELOPE 
 
 
 
FLATRATELEGALENVELOPE 
 
REGIONALRATEBOXA 
 
REGIONALRATEBOXB 
 
FLATRATEGIFTCARDNVELOPE 
 
FLATRATEWINDOWENVELOPE 
 
FLATRATECARDBOARDENVELOPE 
 
SMALLFLATRATEENVELOPE 
 
FLATRATEDVDBOX 
 
FLATRATELARGEVIDEOBOX 
 
FLATRATELARGEBOARDGAMEBOX 
 
HALFTRAYBOX 
 
FULLTRAYBOX 
 
EMMTRAYBOX 
 
FLATTUBTRAYBOX 
 
SACK 

 
Non-rectangular parcel–impacts rate for 
Priority Mail 
Flat Rate Envelope–Priority Mail and Priority 
Mail Express 
Priority Mail Express Flat Rate Box and Priority 
Mail Medium Flat Rate Box. (Deprecated. Was 
removed from XML in the January 2017 
version). 
Medium Flat Rate Box–Priority Mail 
 
Large Flat Rate Box–Priority Mail  
 
Small Flat Rate Box–Priority Mail  
 
Flat Rate Padded Envelope–Priority Mail, 
Priority Mail Express, Priority Mail 
International, Priority Mail Express 
International 
Flat Rate Legal Envelope–Priority Mail and 
Priority Mail Express (Domestic only) 
Regional Rate Box A–Priority Mail 
 
Regional Rate Box B–Priority Mail 
 
Flat Rate Giftcard Envelope–Priority Mail and 
Priority Mail Express (Domestic only) 
Flat Rate Window Envelope–Priority Mail and 
Priority Mail Express (Domestic only) 
Flat Rate Cardboard Envelope–Priority Mail 
and Priority Mail Express (Domestic only) 
Small Flat Rate Envelope–Priority Mail and 
Priority Mail Express (Domestic only) 
Flat Rate DVD Box–Priority Mail International 
only 
Flat Rate Large Video Box–Prioritiy Mail 
International Only 
Flat Rate Large Board Game Box–Priority Mail 
 
For use with Priority Mail Open and Distribute 
(PMOD) (Domestic only) 
For use with PMOD (Domestic only) 
 
For use with PMOD (Domestic only) 
 
For use with PMOD (Domestic only) 
 
For use with PMOD and EMOD (Domestic 
only) 

CubicIndicator Text  
RECTANGULAR 
 
 
 
SOFTPACK 

Applicable only for Priority Mail Parcel.  
Used for traditional cubic pricing for 
rectangular and non-rectangular parcels in 
which Length, Width, and Height are 
considered. (Default value) 
Used for cubic soft pack and padded envelopes 
in which only length and width are considered. 
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Element Type Size or Values Description 
ReplyPostage Text TRUE 

 
FALSE 

TRUE indicates that the item should print with 
reply postage. The Return and Destination 
addresses will be reversed when printing. 

WeightOz Numeric 0.0 to 1130.0 ounces Set the weight of the package in ounces–to 
ONE decimal place. 

Width Numeric 0.00 to 130.00 inches Set the width of envelope, flat, or package. 
This value is required for qualified customers 
to access the Cubic Rectangular and Cubic Soft 
Pack Commercial Plus Pricing. If left blank, 
DAZzle will return weigh-base pricing. 

Length Numeric 0.00 to 130.00 inches Set the length of envelope, flat or package. 
This value is required for qualified customers 
to access the Cubic Rectangular and Cubic Soft 
Pack Commercial Plus Pricing. If left blank, 
DAZzle will return weigh-base pricing. 

Depth Numeric 0.00 to 130.00 inches Set the depth (also used for height or 
thickness) of envelope, flat, or package.  
This value is required for qualified customers 
to access the Cubic Rectangular Commercial 
Plus Pricing. It is not required for Cubic Soft 
Pack Commercial Plus Pricing. If left blank, 
DAZzle will return weigh-base pricing. 

BalloonRate Text TRUE 
 
FALSE 

TRUE means use the “balloon rate”.  

NonMachinable Text TRUE 
 
FALSE 

TRUE means use non-machinable rates.  
Applies to cards, letters and flats only. 

OversizeRate Text TRUE 
 
FALSE 

TRUE means use oversized rate–
NonMachinable MUST also be TRUE. 

Stealth Text TRUE 
 
FALSE 

Use TRUE to turn on Stealth Postage™ which 
hides the postage value.  
Use FALSE to turn off Stealth Postage.  
NOTE: Stealth Postage cannot be used with 
some extra services. 

SpecialContents  Text  
 
 
LIVEANIMALS 
 
LIVEANIMALSDAYOLDPOULTRY 
 
HAZMAT 
 
CREMATEDREMAINS 
 
PERISHABLE 
 
FRAGILE 

Some mailable item types that require Special 
Handling must be declared. 
 
Live animals. Do not use for day-old poultry. 
 
Day-old poultry. 
 
Hazardous materials. 
 
Human or animal cremated remains. 
 
Perishable items. 
 
Fragile items. 

RetailIndicator Text TRUE 
 
FALSE 

For First-Class parcel shipments, use TRUE to 
force the use of retail pricing when postal rules 
require such classification. It is ignored for any 
other mail class and package type 
combinations. 

PriorityMailExpressDeliveryOp
tions 

Node n/a Delivery options for Priority Mail Express 
Note: This node replaced the node 
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Element Type Size or Values Description 
<ExpressMailDeliveryOptions>, which was 
deprecated and removed from XML in the April 
2016 version. 

 SignatureRequired Attribute TRUE 
 
FALSE 

Use TRUE to indicate that a signature is 
required upon delivery.  
Signature is required for Priority Mail Express 
shipments when Adult Signature, COD, USPS 
insurance, or Hold For Pickup has been 
selected. 

SaturdayDelivery Attribute TRUE 
 
FALSE 

Use TRUE to indicate Saturday delivery 
requested. Default value is TRUE. 

SundayDelivery Attribute TRUE 
 
FALSE 

Use TRUE to indicate Sunday delivery 
requested. 

HolidayDelivery Attribute TRUE 
 
FALSE 

Use TRUE to indicate holiday delivery 
requested.  

PriorityMailExpress1030 Attribute TRUE 
 
FALSE 

Use TRUE to indicate Priority Mail Express 
10:30 AM delivery has been requested.  

Services Node  Extra Services requested for the package. 
 RegisteredMail Attribute ON 

 
OFF 

Registered Mail requested 
 
Registered Mail not requested 

InsuredMail Attribute ENDICIA 
 
ON 
 
 
OFF 
 
UPIC 

Endicia Parcel Insurance requested. 
 
USPS Insurance requested 
Note: USPS Insurance is not allowed with 
Stealth=TRUE 
No insurance requested 
 
UPIC insurance requested 
 

CertifiedMail Attribute ON 

 
OFF 

Certified Mail requested 

 
Certified Mail not requested 

RestrictedDelivery Attribute ON 

 
OFF 

Restricted Delivery requested 

 
Restricted Delivery not requested 

CertificateOfMailing Attribute ON 

 
OFF 

Certificate Of Mailing requested 

 
Certificate Of Mailing not requested 

ReturnReceipt Attribute ON 

 
OFF 

Return Receipt requested 

 
Return Receipt not requested 

ReturnReceiptEndorsement 

 

Attribute ON 

 
OFF 

Return Receipt endorsement is printed on the 
label. 

Return Receipt endorsement is not printed on 
the label. 
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Element Type Size or Values Description 
DeliveryConfirmation  Attribute ON 

 
 
OFF 

USPS Tracking has been requested. This also 
applies to International E-Delivery 
Confirmation (eDelCon) 
USPS Tracking has not been requested. 
(Deprecated. The USPS has renamed domestic 
Delivery Confirmation to USPS Tracking. 
Therefore a new USPSTracking tag is replacing 
this tag. However, this tag will continue to be 
valid until further notice. If the USPSTracking 
tag is used, it will override the 
DeliveryConfirmation tag.) 

USPSTracking Attribute ON 
 
 
OFF 

USPS Tracking or Electronic Delivery 
Confirmation International (eDelCon) has 
been requested. 
USPS Tracking not requested. 
 
Note: For mail classes where USPS Tracking or 
eDelCon is free, this tag will be ignored. 

SignatureConfirmation  Attribute ON 

 
OFF 

Signature Confirmation requested (also used 
for Signature Service) 

Signature Confirmation not requested 
AdultSignatureRequired  Attribute ON 

 
OFF 

Adult Signature Required requested 

 
Adult Signature Required not requested 

AdultSignatureRestricted  Attribute ON 

 
OFF 

Adult Signature Restricted requested 

 
Adult Signature Restricted not requested 

COD Attribute ON 

 
OFF 

COD requested 

 
COD not requested 

HoldForPickup Text TRUE 
 
FALSE 

Hold For Pickup requested 
 
Hold For Pickup not requested 

HFPFacilityID Text 20 Facility ID of the Post Office that will hold the 
item for pickup. 

HFPFacilityName Text 150 Facility name of the Post Office that will hold 
the item for pickup. 

HFPFacilityAddress Text 150 Facility address of the Post Office that will hold 
the item for pickup. 

HFPFacilityCity Text 50 City of the Post Office that will hold the item 
for pickup. 

HFPFacilityState Text 25 State of the Post Office that will hold the item 
for pickup. 

HFPFacilityZip5 Text 5 5 digit ZIP Code of the Post Office that will hold 
the item for pickup. 

HFPFacilityZip4 Text 4 +4 add-on ZIP Code of the Post Office that will 
hold the item for pickup. 

OpenAndDistribute Text TRUE 
 
FALSE 

For Priority Mail Express or Priority Mail, use 
TRUE to specify an OpenAndDistribute label. 

MailClassEnclosed Text 50 Required when OpenAndDistribute is TRUE. 
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Element Type Size or Values Description 
Used with OpenAndDistribute. Type of mail 
class enclosed. No validation. Some typical 
values: Standard Mail Letters, Standard Mail 
Flats, Standard Mail Parcels, or specify other 
value.  

CostCenter Numeric 8 Cost-center code for accounting purposes 
Value Currency 99,999.99 Value of the item shipped. Used for insurance 

and other extra services (to the cent). 
Required if an extra service is used that 
requires this value. For items that use the 
international mail customs forms, this value 
must be the sum of the individual customs 
items.  

Description Text 50 Description of the item shipped. Used for 
authentication by recipient. 

CustomsFormType Text  
 
 
NONE 
 
CN22 
 
CP72 

Conditionally used only for international, US 
Territory, or APO/FPO/DPO shipments. 
Type of customs form to create. 
No customs form. 
 
CN22 is the same as PS Form 2976. 
 
CP72 is the same as PS Form 2976-A. 
(Deprecated. Endicia software will pick the 
correct form type based on shipment 
parameters entered. Values in this element 
will be ignored. This element was removed 
from XML in the April 2016 version.) 

CustomsSendersCopy Text TRUE 
 
FALSE 

Conditionally used only for shipments that 
require integrated customs forms. Use TRUE to 
print a sender’s copy of the customs form. 

CustomsDescriptionN Text 50 Required for shipments that require integrated 
customs forms. "N" can be any integer from 1 
through 1000.  
Detailed description of the "Nth" item in the 
customs declaration. 

CustomsQuantityN Numeric 8 Required for shipments that require integrated 
customs forms. "N" can be any integer from 1 
through 1000.  
Quantity of the "Nth" item in customs 
declaration. 

CustomsWeightN Numeric 8 Required for shipments that require integrated 
customs forms. "N" can be any integer from 1 
through 1000.  
Net weight of the "Nth" item in customs 
declaration–in ounces. 

CustomsValueN Currency 99,999.99 Required for shipments that require integrated 
customs forms. "N" can be any integer from 1 
through 1000.  
Value (in U.S. dollars) of the "Nth" item in the 
customs declaration.  

CustomsHTSN Numeric 10 Conditionally used for shipments that require 
integrated customs forms. "N" can be any 
integer from 1 through 1000.  
Harmonized Tariff Schedule (HTS) number for 
the "Nth" item in customs declaration.  
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Element Type Size or Values Description 
CustomsCountryN Text 25 Conditionally used for shipments that require 

integrated customs forms. "N" can be any 
integer from 1 through 1000.  
Country of Origin for the "Nth" item in the 
customs declaration. This MUST be a valid, 
USPS recognized country.  

ContentsType Text 120 Required for shipments that require integrated 
customs forms. 
Type of contents. The value will be printed as 
entered in the Contents field on the customs 
form. Recommended standard values appear 
in the following list, but an "other" type may 
be entered. Enter all types that apply as plain 
text separated by commas. 

 Gift 
 Documents 
 Merchandise 
 Returned Goods 
 Commercial Sample 
 Humanitarian Donation 
 Dangerous Goods 

LicenseNo Text 20 Conditionally used for shipments that require 
integrated customs forms. 
License number. 

CertificateNo Text 20 Conditionally used for shipments that require 
integrated customs forms. 
Certificate number. 

InvoiceNo Text 20 Conditionally used for shipments that require 
integrated customs forms. 
Invoice number. 

Comments Text 80 Conditionally used for shipments that require 
integrated customs forms. 
Identify if special conditions or restrictions 
apply to items being mailed. For example, if 
the contents are subject to quarantine 
restrictions. This data will not be printed on 
the integrated customs form. 

SendersCustomsReference Text 30 Conditionally used for shipments that require 
integrated customs forms. 
Sender’s customs reference. 

ImportersCustomsReference Text 30 Conditionally used for shipments that require 
integrated customs forms. 
Importer’s customs reference (might be a tax 
code, importer code, or VAT number used for 
sales tax). 

AesItnExemption Text 20 Conditionally used for shipments that require 
integrated customs forms. 
Except for shipments to APO/FPO/DPO 
addresses, enter an Automated Export System 
(AES) Internal Transaction Number (ITN), AES 
Exemption, or if applicable, an AES Downtime 
Citation. 
Default value: NOEEI 30.37(a) 

International Node n/a Conditionally used for shipments that require 
integrated customs forms.  

 IfNonDeliverable Attribute  
Abandon 

Instructions if shipment is non-deliverable. 
Treat as abandoned. 
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Element Type Size or Values Description 
 
Return 
 
Forward 

 
Return to sender (default value). 
 
Redirect to alternate address. 

Address1 Attribute 36 Required if Forward is the value set for 
IfNonDeliverable. 
Redirect address (Forward only) 

Address2 Attribute 36 Redirect address (Forward only) 
Address3 Attribute 36 Redirect address (Forward only) 
Address4 Attribute 36 Redirect address (Forward only) 

CustomsSigner Text 100 Conditionally used for shipments that require 
integrated customs forms. 
Name of person certifying that the customs 
information is correct. This name will be 
printed on the customs form in place of a 
signature IF CustomsCertify is TRUE. 

CustomsCertify Text  
 
TRUE 
 
FALSE 

Conditionally used for shipments that require 
integrated customs forms.  
TRUE certifies that all entries are correct and 
the items being mailed contain no undeclared 
dangerous, prohibited, or restricted contents 
per postal, customs, or destination country 
regulations. TRUE also certifies compliance 
with all applicable federal export licensing and 
filing regulations and confirms the 
CustomsSigner’s liability for the items being 
mailed. 

EndorsementLine Text 150 Address endorsement line, for example, 

AutoCR xx **. Always first addressline, if used. 
ReferenceID Text 25 A reference value for logs 
ToName Text 50 Addressee Name 
ToTitle Text 50 Addressee title (follows name line) 
ToCompany Text 50 Addressee company name. Required if 

ToName is blank. 
ToAddress1 Text 50 First destination address line  
ToAddress2 Text 50 Second destination address line  
ToAddress3 Text 50 Third destination address line  
ToAddress4 Text 50 Fourth destination address line  
ToAddress5 Text 50 Fifth destination address line  
ToAddress6 Text 50 Sixth destination address line  
ToCity Text 50 Destination City  
ToState Text 25 Destination State or Province  
ToPostalCode Text 15 Destination postal code.  

 
For domestic shipments, the format is either 
ZIP5 only or ZIP+4. 
 
For Canada shipments a Postal Code is 
required in the following format: six 
characters with no spaces and all capitals in 
the alternating letter-number format 
“A1A1A1”. 

ToZIP4 Text 5 +4 add-on for US addresses. 
ToCountry Text 50 Destination Country. This value should be left 

blank for domestic shipments. 
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Element Type Size or Values Description 
ToDeliveryPoint Text 3 Delivery point digits for destination address 
ToCarrierRoute Text 5 Carrier route code (CRC) for destination 

address. 

If address verification is suppressed you must 
include the CRC here for it to have it uploaded 
to USPS and print on label. 

ToReturnCode Text 3 CASS returncode for address validation. Refer 
to the Values for Status Tag table in the 
Appendix. 

ToEMail Text 150 Email address for recipient–for logging only. 
Either ToEmail or ToSMS is required when 
HoldForPickup is TRUE. 

ToSMS Text 50 A phone number for the recipient that the 
USPS can send SMS messages. Either ToEmail 
or ToSMS is required when HoldForPickup is 
TRUE. 

ToPhone Text 50 Phone number for recipient (required when 
mailing to a P.O. Box and sending through 
First-Class Mail International, Priority Mail 
International, and Priority Mail Express 
International) 

RubberStampN Text 50 Replaces text in the rubber stamp on the 
layout associated with database field "N" (set 
up in the rubber stamp options). "N" can be 
any value from 1 to 100. 

ReturnAddress Text n/a Entire return address as a string with line 
breaks. 

ReturnAddressPhone Text n/a Telephone associated with return address 
(used for Customs form) 
Must include at least one number. 

ReturnAddressEmail Text n/a Email address associated with return address 
(used for Customs form) 

ReturnAddressNickname Text n/a The nickname of an address in the “From” 
Pop-up. Specifiing the nickname allows 
omitting the entire ReturnAddress in each 
request. 

ReturnAddress1 Text 50 First return address line  
ReturnAddress2 Text 50 Second return address line  
ReturnAddress3 Text 50 Third return address line  
ReturnAddress4 Text 50 Fourth return address line  
ReturnAddress5 Text 50 Fifth return address line  
ReturnAddress6 Text 50 Sixth return address line  
Status Text Success or Failure Indicates if the printing succeeded or failed. 

Output only.  

Success–no errors 
Rejected (x)–error occurred 
Refer to the Values for Status Tag table in the 
Appendix for possible error code values. 

PIC Text USPS tracking number Tracking number supplied by the USPS. Output 
only. 

CustomsNumber Text USPS customs number USPS assigned Customs number for Customs 
Forms Declaration. Output only. 

FinalPostage Currency 99,999.99 Actual postage for transaction. Output only. 
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Element Type Size or Values Description 
TransactionID Numeric 0 - 99,999 Unique ID for transaction. Output only. 

Deprecated 
PrintID Numeric  0 - 4,294,967,295 Unique ID for transaction in Endicia system. 

Output only.  
TransactionDateTime Date YYYYMMDDHHMMSS Date and time the transaction was created. 

Output only. 
PostmarkDate Date YYYYMMDD Indicates the postmark date. Output only. 
PostageBalance Currency 99,999.99 Postage balance remaining in account. Output 

only. 
RetailPostage Currency 999.99 Postage amount for the same item if it was 

purchased at a USPS retail counter. Used for 
comparison purposes. 

 

Syntax Sample of a Printing XML File  
The following listing shows a syntax sample of a Printing XML file.  
 

Listing 4—1: Sample Printing XML 

<DAZzle Layout="c:\Users\Public\Documents\Endicia\DAZzle\Dymo4XL Label.lyt" Prompt='YES' 
Test='NO' Start='PRINTING' OutputFile='C:\DAZZLE sample.XML' AutoClose='NO' 
PartnerID=’A1B2’> 
 <Package ID='1'> 
  <MailClass>PRIORITY</MailClass> 
  <DateAdvance>4</DateAdvance> 
  <PackageType>FLATRATEENVELOPE</PackageType> 
  <WeightOz>5</WeightOz> 
  <Width>5</Width> 
  <Length>12.0</Length> 
  <Depth>5.5</Depth> 
  <OversizeRate>FALSE</OversizeRate> 
  <Services  

CertifiedMail="OFF"  
USPSTracking="ON"> 

  </Services> 
  <Value>27.00</Value> 
  <Description>t-shirts</Description> 
  <ReferenceID>0038005</ReferenceID> 
  <ToName>Mrs. Sample Name</ToName> 
  <ToAddress1> 278 Castro St</ToAddress1> 
  <ToCity>Mountain View</ToCity> 
  <ToState>CA</ToState> 
  <ToPostalCode>94041</ToPostalCode> 
  <ToEMail>SampleName@notreal.org</ToEMail> 
 </Package> 
</DAZzle> 
 

Listing 4—2: Sample Printing XML for International Shipment 

<DAZzle Layout=”c:\Users\Public\Documents\Endicia\DAZzle\International Label - Small 
6x4.lyt” Prompt="YES" Test="NO" Start="PRINTING" OutputFile="C:\singleintlout.xml" 
AutoClose="NO" PartnerID=’A1B2’> 
 <Package ID="1"> 
  <MailClass>INTLPRIORITY</MailClass> 
  <PackageType>RECTPARCEL</PackageType> 
  <WeightOz>40</WeightOz> 
  <Services 
   RegisteredMail = 'OFF' 
   InsuredMail = 'ON' 
   CertifiedMail = 'OFF' 
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   RestrictedDelivery = 'OFF' 
   CertificateOfMailing = 'OFF' 
   ReturnReceipt = 'OFF' 
   USPSTracking= 'OFF' 
   SignatureConfirmation = 'OFF' 
   COD = 'OFF' > 
  </Services> 
  <Value>24.45</Value> 
  <Description>Men’s cotton shirt</Description> 
  <CustomsDescription1>Men’s Cotton Shirt</CustomsDescription1> 
  <CustomsQuantity1>1</CustomsQuantity1> 
  <CustomsWeight1>40</CustomsWeight1> 
  <CustomsValue1>24.45</CustomsValue1> 
  <CustomsCountry1>Italy</CustomsCountry1> 
  <ContentsType>Merchandise, Humanitarian Donation</ContentsType> 
  <LicenseNo>123456</LicenseNo> 
  <CertificateNo>987654</CertificateNo> 
  <Comments>Restricted item</Comments> 
  <SendersCustomsReference>123456</SendersCustomsReference> 
  <ImportersCustomsReference>123456</ImportersCustomsReference> 
  <AesItnExemption>NOEEI 30.37(h)</AesItnExemption> 
  <International  
   IfNonDeliverable="Forward"  
   Address1="Customer Service"  
   Address2="2701 RIVERSIDE DR."  
   Address3="OTTAWA, ON K1A 0B1" 
   Address4="CANADA" 
   /> 
  <CustomsSigner>Joe Shipper</CustomsSigner> 
  <CustomsCertify>TRUE</CustomsCertify> 
  <ToName>Joe Bloe</ToName> 
  <ToAddress1>1900 Queen Mary Ave</ToAddress1> 
  <ToCity>Brampton</ToCity> 
  <ToState>ON</ToState> 
  <ToPostalCode>L7A1Y3</ToPostalCode> 
  <ToCountry>CANADA</ToCountry> 
  <ToEMail>sample@endiciasample.com</ToEMail> 
  <ReturnAddressPhone>1-123-456-7890</ReturnAddressPhone> 
  <ReturnAddressEmail>receiver@endiciatest.com</ReturnAddressEmail> 
  <RubberStamp1>Item Description</RubberStamp1> 
  <RubberStamp2>381099999</RubberStamp2> 
 </Package> 
</DAZzle> 
 

Listing 4—3: Sample Printing XML for Multiple Shipments 

<DAZzle Start='PRINTING' Prompt='YES' AutoClose='NO' OutputFile='c:\testout.xml' 
Test='YES' PartnerID=’A1B2’> 

<Package ID="1"> 
        <MailClass>FIRST</MailClass> 
        <PackageType>ENVELOPE</PackageType> 
        <DateAdvance>0</DateAdvance> 
        <WeightOz>5</WeightOz> 
        <Services  

InsuredMail="ON"  
USPSTracking="OFF" 
COD="OFF"> 

        </Services> 
        <CostCenter>25</CostCenter> 
        <Value>25.00</Value> 
        <Description>test 1</Description> 
        <ReferenceID>10</ReferenceID> 
        <ToName>Mark Thomas</ToName> 
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        <ToCompany>PSI</ToCompany> 
        <ToAddress1> 278 Castro St</ToAddress1> 
        <ToCity>Mountain View</ToCity> 
        <ToState>CA</ToState> 
        <ToPostalCode>94041</ToPostalCode> 
        <ToEMail>sample@endiciasample.com</ToEMail> 
        <ToPhone>650-555-1212</ToPhone> 
</Package> 
<Package ID="2"> 
        <MailClass>PRIORITY</MailClass> 
        <PackageType>RECTPARCEL</PackageType> 
        <DateAdvance>0</DateAdvance> 
        <WeightOz>16</WeightOz> 
        <Services  

USPSTracking="ON"  
COD="OFF"> 

        </Services> 
        <CostCenter>35</CostCenter> 
        <Value>35.00</Value> 
        <Description>test 2</Description> 
        <ReferenceID>20</ReferenceID> 
        <ToName>Jessie Montgomery</ToName> 
        <ToCompany></ToCompany> 
        <ToAddress1>110 Main St</ToAddress1> 
        <ToCity>Los Altos</ToCity> 
        <ToState>CA</ToState> 
        <ToPostalCode>94024</ToPostalCode> 
</Package> 
<Package ID="3"> 
        <MailClass>PRIORITYEXPRESS</MailClass> 
        <PackageType>FLATRATEBOX</PackageType> 
        <DateAdvance>0</DateAdvance> 
        <WeightOz>16</WeightOz> 
        <PriorityMailExpressDeliveryOptions  

SignatureRequired="FALSE" 
SaturdayDelivery="FALSE" 
SundayDelivery="TRUE" 
HolidayDelivery="TRUE" /> 

        <Services  
SignatureConfirmation="ON"> 

        </Services> 
        <CostCenter>45</CostCenter> 
        <Value>45.00</Value> 
        <Description>test 3</Description> 
        <ReferenceID>30</ReferenceID> 
        <ToName>Susan Williams</ToName> 
        <ToCompany></ToCompany> 
        <ToAddress1>818 Carmel Ave</ToAddress1> 
        <ToCity>Los Altos</ToCity> 
        <ToState>CA</ToState> 
        <ToPostalCode>94022</ToPostalCode> 
</Package> 

</DAZzle> 
 

Output Information 

DAZzle returns printing information in XML format when printing from an XML file source (that is, it does NOT create 
output when printing from the Clipboard). The output data are in the same XML format as was supplied. If the 
application had updated a data element, the output file contains the updated element (for example, address data had 
changed during the verification process). If the data element is NOT in the original source data, the application will add 
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the information to the output XML. For information about each tag that is updated or added, see the Endicia Client XML 
Printing Syntax section. 
 
The location of the output data varies depending on the source (input). 
 

 For an external file, when printing from a file, DAZzle prompts the user for the name of an output file to store 
the results. The default name is the source file name with “output” appended (for example filename-
output.xml). When using automated printing with the Prompt element set to no, the default file name is 
automatically used (any existing file with this name will be overwritten). 

 For the Clipboard, DAZzle does not return any information to the Clipboard when using XML. If return 
information is desired, use a file-based approach.  
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5. ADDRESS VERIFICATION  
Verifying a list of addresses can be accomplished with an appropriately formatted XML file. 
 

Address Verification XML Syntax 

The Address Verification XML syntax is actually the same as the syntax for Client Printing, except many tags are not 
required (or otherwise ignored). The minimum set of data is listed in detail in the following table.  

Note: Address verification through XML cannot be fully automated; it will always have user prompts and cannot 
be started using directory monitoring. 

 
The following applies to all elements in the following table: 

 Italic items are optional.  
 Bold items are exported (or added if missing). 

 

Table 5—1: XML Address Verification Elements 

Element Type Size or Values Description 
DAZzle Root - The root node for the XML request. 
 Package Node - Package information. 

 ID Numeric 1-n Numeric identifier for each address in the 
request. There may be multiple address 
(indicium) requests. 

ToName Text 50 Destination Name.  
ToTitle Text 50 Title (follows name line). 
ToCompany Text 50 Company name.  
ToAddress1 Text 50 First address line.  
ToAddress2 Text 50 Second address line.  
ToAddress3 Text 50 Third address line.  
ToAddress4 Text 50 Fourth address line.  
ToAddress5 Text 50 Fifth address line.  
ToAddress6 Text 50 Sixth address line.  
ToCity Text 50 Destination City.  
ToState Text 25 Destination State or Province.  
ToPostalCode Text 15 Destination postal code.  

 
For domestic shipments, the format is either 
ZIP5 only or ZIP+4. 
 
 
For Canada shipments a Postal Code is 
required in the following format: six 
characters with no spaces and all capitals in 
the alternating letter-number format 
“A1A1A1”. 

ToZIP4 Text 5 +4 add-on for US addresses. 
ToCountry Text 50 Destination Country. 
ToDeliveryPoint Text 3 Delivery point digits for destination address. 
ToCarrierRoute Text 5 Carrier route code (CRC) for destination 

address. 
ToReturnCode Text 3 CASS return code for address validation 

Refer to the Values for Status Tag table in 
the Appendix. 
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Syntax Sample for an Address Verification XML File  
The following listing gives a syntax sample for an Address Verification XML file.  

Listing 5—1: Address Verification XML 

<DAZzle> 
 <Package ID="x"> 
  <ToName></ToName> 
  <ToTitle></ToTitle> 
  <ToCompany></ToCompany> 
  <ToAddress1></ToAddress1> 
  <ToAddress2></ToAddress2> 
  <ToAddress3></ToAddress3> 
  <ToAddress4></ToAddress4> 
  <ToAddress5></ToAddress5> 
  <ToAddress6></ToAddress6> 
  <ToCity></ToCity> 
  <ToState></ToState> 
  <ToPostalCode></ToPostalCode> 
  <ToZIP4></ToZIP4> 
  <ToCountry></ToCountry> 
  <ToDeliveryPoint></ToDeliveryPoint> 
  <ToCarrierRoute></ToCarrierRoute> 
  <ToReturnCode></ToReturnCode> 
 </Package> 
</DAZzle> 
 

Output Information 

DAZzle updates the source data with the results of the address verification process. The output data is in the same XML 
format as was supplied. If DAZzle updated a data element, the output file will contain the updated element. If the data 
element is NOT in the original source data, DAZzle will add the information to the XML data. Refer to the Address 
Verification XML listing for details on each tag that is updated or added.  
 

Note: The verification process truly updates the source data. This is different than printing with XML that only 
includes printed items in the output result set. If an address fails verification, it is still updated with the return 
code that indicates why the verification failed. 
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6. ADDRESS BOOK  
Data may be imported into or exported from the DAZzle Address Book through XML-formatted text files. 
 
Topics in this section include: 
 

 Import XML Data 
 Export XML Data 

Import Address Book XML Data  

The following Steps describe how to import data into the DAZzle Address Book using XML. 
 
Steps 
 

1. Select the Address Book tab. 
2. Select File > Import….  
3. Change the file type to “Text, XML Format” and select the XML file.  

If the file is a properly formatted XML file, all of the data items will be immediately imported (added) to the 
DAZzle Address Book. 

 

Export Address Book XML Data 

The following Steps describe how to export DAZzle Address Book information to an XML-formatted file. 
 
Steps 
 

1. Select the Address Book tab. 
2. Select File > Export….  
3. Change the file type to “Text, XML format” and select a file name with an XML extension. 

DAZzle exports all selected addresses to that file in XML format. 
 
The following applies to all elements in the following table: 
 

 Italic items are optional.  
 Bold items are exported (or added if missing). 

 

Table 6—1: XML Address Book Elements 

Element Type Size or Values Description 
DAZzle Root - The root node for the XML request. 
 Package Node - Package information. 

 ID numeric 1-n Numeric identifier for each address in the 
request. There may be multiple addresses. 

ToSalutation Text 50 Salutation (for example Mr., Mrs., Dr., etc.), 
export only 

ToFirstName Text 50 First name, export only 
ToMiddleName Text 50 Middle name, export only 
ToLastName Text 50 Last name, export only 
ToName Text 50 Name  
ToTitle Text 50 Title (follows name line) 
ToCompany Text 50 Company name  
ToAddress1 Text 50 First address line  
ToAddress2 Text 50 Second address line  
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Element Type Size or Values Description 
ToAddress3 Text 50 Third address line  
ToAddress4 Text 50 Fourth address line  
ToAddress5 Text 50 Fifth address line  
ToAddress6 Text 50 Sixth address line  
ToCity Text 50 City  
ToState Text 25 State or province  
ToPostalCode Text 15 Destination postal code.  

 
For domestic shipments, the format is either 
ZIP5 only or ZIP+4. 
 
For Canada shipments a Postal Code is 
required in the following format: six 
characters with no spaces and all capitals in 
the alternating letter-number format 
“A1A1A1”. 

ToZIP4 Text 5 +4 add-on for US addresses 
ToCountry Text 50 Country 
ToDeliveryPoint Text 3 Delivery point digits for address 
ToCarrierRoute Text 5 Carrier route code (CRC) for address 
ToReturnCode Text 3 CASS return code for address validation 

Refer to the Values for Status Tag table in 
the Appendix. 

ToCASSDate Date YYYYMMDD Date of CASS verification 
ToEmail Text 100 Email address 
ToPhone Text 20 Phone number for recipient (required when 

mailing to a P.O. Box and sending through 
First-Class Mail International, Priority Mail 
International, and Priority Mail Express 
International) 

 

Listing 6—1: Address Book XML 

<DAZzle> 
 <Package ID="x"> 
  <ToName></ToName> 
  <ToTitle></ToTitle> 
  <ToCompany></ToCompany> 
  <ToAddress1></ToAddress1> 
  <ToAddress2></ToAddress2> 
  <ToAddress3></ToAddress3> 
  <ToAddress4></ToAddress4> 
  <ToAddress5></ToAddress5> 
  <ToAddress6></ToAddress6> 
  <ToCity></ToCity> 
  <ToState></ToState> 
  <ToPostalCode></ToPostalCode> 
  <ToZIP4></ToZIP4> 
  <ToCountry></ToCountry> 
  <ToDeliveryPoint></ToDeliveryPoint> 
  <ToCarrierRoute></ToCarrierRoute> 
  <ToReturnCode></ToReturnCode> 
  <ToEMail></ToEMail> 
  <ToPhone></ToPhone> 
 </Package> 
</DAZzle> 
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7. POSTAGE LOG 
Data may be exported from the DAZzle Postage Log into XML-formatted text files. 
 

Export Postage Log XML Data  

The following Steps describe how to export DAZzle Postage Log information to an XML-formatted file. 
 
Steps 
 

1. Select the Postage Log tab. 
2. Select File > Export….  
3. On the Export Date Range dialog box, enter the starting date and ending date of data to export. 
4. Click Export.  
5. Select the file type of Text, XML format, enter the file name, and click Save. DAZzle exports all Postage Log 

records for the selected date range to that file in XML format. 

Table 7—1: XML Postage Log Elements 

Element Type Size or Values Description 
DAZzleLog Root - The root node for the XML 
 Account Attribute  Endicia account number 
 Name Attribute  Name 
 Phone Attribute  Phone number 
 Email Attribute  Email address 
 Record Node - Record information  

 ID Numeric 
attribute 

1-n Numeric identifier for each record. 
Sequential entry in the log file.  

Account Text 6 Six-digit customer account number 
DeviceID Text 10 Corresponds to the device ID printed with 

each postage indicia. 
AccountName Text 60 Sender’s name 
TransactionID Numeric  Unique ID for transaction–corresponds to 

the piece count for the account used. 
TransactionDateTime Date mm/dd/yyyy hh:mm AM Date and time the transaction was 

completed. 
Status Text Success or Failure Success means transaction completed 

successfully. 
TransactionType Numeric 2 07 is postage purchase.  

08 is a “stamp”. 
AccountBalance Currency 10 Funds remaining in account after 

transaction 
ToEMail Text 150 Email address for recipient–for logging only 
ToPhone Text 50 Phone number for recipient (required when 

mailing to a P.O. Box and sending through 
First-Class Mail International, Priority Mail 
International, and Priority Mail Express 
International) 

PostmarkDateTime Date MM/DD/YYYY Postmark date printed with indicia 
ToAddress Text 50 First address line  
ToPostalCode Text 15 Destination postal code.  

 
For domestic shipments, the format is either 
ZIP5, ZIP+4, or ZIP+4 plus 2-digit delivery 
point. 

FinalPostage Currency 99,999.99 Actual postage for transaction 
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Element Type Size or Values Description 
MailClass text None 

First Class 
First Class, Postcard 
Priority Mail 
(and so on) 

Mail class used for the item. 

Services Node - Special Services requested for the package. 
 RegisteredMail Attribute ON 

 
OFF 

Registered Mail requested 
 
Registered Mail not requested 

InsuredMail  Attribute ON 
 
OFF 

Insurance requested 
 
Insurance not requested 

CertifiedMail Attribute ON 
 
OFF 

Certified Mail requested 
 
Certified Mail not requested 

RestrictedDelivery Attribute ON 
 
OFF 

Restricted Delivery requested 
 
Restricted Delivery not requested 

CertificateOfMailing Attribute ON 
 
OFF 

Certificate Of Mailing requested 
 
Certificate Of Mailing not requested 

ReturnReceipt Attribute ON 
 
OFF 

Return Receipt requested 
 
Return Receipt not requested 

USPSTracking Attribute ON 
 
OFF 

USPSTracking requested 
 
USPSTracking not requested 

SignatureConfirmatio
n  

Attribute ON 
 
OFF 

Signature Confirmation® requested 
 
Signature Confirmation not requested 

AdultSigRequired Attribute ON 
 
OFF 

Adult Signature Required requested 
 
Adult Signature Required not requested 

AdultSigRestricted Attribute ON 
 
OFF 

Adult Signature Restricted requested 
 
Adult Signature Restricted not requested 

COD Attribute ON 
 
OFF 

COD requested 
 
COD not requested 

WeightOz Numeric 6 Weight of the package in ounces 
PIC Text USPS tracking number Tracking number supplied by the USPS 
Description Text 50 Description of the item shipped. Used for 

authentication by recipient. 
Value Currency 99,999.99 Value of the item shipped. Used for 

insurance and other optional services (to 
the cent). 

ReferenceID Text 25 A reference value for logs 
CostCenter Numeric 8 Cost center code for accounting purposes–

this is listed as Group Code in the DAZzle 
Print dialog box. 

CustomsID Text 15 Customs ID associated with international 
mail items 

Insurance Text UPIC 
ENDICIA 
USPS 
NONE 

Type of insurance used 
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Element Type Size or Values Description 
ReplyPostage Text YES 

NO 
Was Reply Postage used? 

Reprinted Text YES 
NO 

Was the item reprinted? 

RefundStatus Text YES 
NO 

Was e-refund selected for this item? 

DeliveryStatus Text  Coded field indicating the delivery status of 
the item (if some form of tracking was 
used). 

DeliveryDescription Text 50 Delivery status description from the USPS 
CustomsContentType Numeric 0=Sample 

1=Gift 
2=Documents 
3=Other 
4=None 
5=Returned goods 

Content Type selected on customs forms (if 
applicable) 

CustomsDescriptionN Text 25 Description for line N of customs form 
CustomsQuantityN Numeric 10 Quantity for line N of customs form 
CustomsWeightN Numeric 10 Weight (ounces) for line N of customs form 
CustomsValueN Currency 10 Value for line N of customs form 
CustomsCountryN Text 25 Origin Country for line N of customs form 

 

Listing 7—1: Postage Log XML 

<DAZzleLog Account='601225' Name='Joe Customer’ Phone='(650) 555-2640' 
Email='joe@companyname.com'> 
<Record ID="6990"> 
<Account>601225</Account> 
<DeviceID>071V00601225</DeviceID> 
<AccountName> Joe Customer </AccountName> 
<TransactionID>12289</TransactionID> 
<TransactionDateTime>09/06/2006 10:24 AM</TransactionDateTime> 
<Status>Success</Status> 
<TransactionType>08</TransactionType> 
<AccountBalance>40,627.302</AccountBalance> 
<PostmarkDateTime>09/06/2006</PostmarkDateTime> 
<ToAddress>DAVID Recipient, 15021 NE 31st St, Vancouver, WA 98682-8302</ToAddress> 
<ToPostalCode>98682830221</ToPostalCode> 
<FinalPostage>1.73</FinalPostage> 
<MailClass>Package, Media Mail</MailClass> 
<Services USPSTracking= 'ON'></Services> 
<WeightOz>16</WeightOz> 
<PIC>9102148008600000012345</PIC> 
<Description>AOB 290014164666-370802792</Description> 
<Value>0.00</Value> 
<CostCenter>0</CostCenter> 
<Insurance>NONE</Insurance> 
<ReplyPostage>NO</ReplyPostage> 
<Reprinted>NO</Reprinted> 
<CustomsContentType>4</CustomsContentType> 
</Record> 
<Record ID="7002"> 
<Account>601225</Account> 
<DeviceID>071V00601225</DeviceID> 
<AccountName> Joe Customer </AccountName> 
<TransactionID>12301</TransactionID> 
<TransactionDateTime>09/07/2006  4:52 PM</TransactionDateTime> 
<Status>Success</Status> 
<TransactionType>08</TransactionType> 
<AccountBalance>40,586.192</AccountBalance> 
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<PostmarkDateTime>09/07/2006</PostmarkDateTime> 
<ToAddress>Fernando Imagine, 17 Calle Bonaparte Apt 1, Caguas, PR 00725-7101</ToAddress> 
<ToPostalCode>00725710101</ToPostalCode> 
<FinalPostage>18.80</FinalPostage> 
<MailClass>PRIORITYEXPRESS</MailClass> 
<Services></Services> 
<WeightOz>16</WeightOz> 
<PIC>EO010000203US</PIC> 
<Value>0.00</Value> 
<CostCenter>0</CostCenter> 
<Insurance>NONE</Insurance> 
<ReplyPostage>NO</ReplyPostage> 
<Reprinted>NO</Reprinted> 
<CustomsContentType>4</CustomsContentType> 
</Record> 
</DAZzleLog> 
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Appendix A. Address Verification Return Code Values 
The following table shows the address verification return code values. 

Address Verification Return Code Values 

Value Description 
10 
 

Invalid address 

11 
 

Invalid Zip Code 

12 
 

Invalid state code 

13 
 

Invalid city 

21 
 

Address not found 

22 
 

Multiple matches, too ambiguous 

25 
 

City, State, and ZIP Code are valid, but street address is not a match. 

31 
 

Exact match 

32 
 

Default match, more information may give a more specific +4 
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Appendix B. Values for Status Tags 
The following table shows the values for status tags. 

Values for Status Tags 

Value Description 
0 
 

Success--no errors during processing 

-3 
 

Address Verification failed (return code less than 25) 

-4 
 

Unsupported mail class for international mail or invalid weight/rate values 

-5 
 

Unsupported domestic mail options (Windows only) 

-6 
 

USPS USPSTracking error–denied, service unavailable or communication error 

-7 
 

USPS Priority Mail Express error–denied, service unavailable or communication error 

-8 
 

USPS Customs Forms error–denied, service unavailable or communication error 

-9 
 

International Mail Shipping Label (large or small) processing error 

-10 
 

CONFIRM service error–denied, service unavailable or communication error 

-11 
 

Priority Mail Express International, Priority Mail International, or First-Class Mail International Error–
no "to phone" for mail addressed to PO Boxes. 

-12 
 

Invalid feature for account. 

-13 
 

Invalid Priority Mail Express option. Priority Mail Express options are supported in a node named 
"PriorityMailExpressDeliveryOptions" to comply with the USPS. Please reformat your XML using this 
node.  

 



 

CONFIDENTIAL Endicia Page 36 

Appendix C. Interface for Consolidators  

Overview 
 
This Overview contains the following topics: 

 About the Interface for Consolidators  
 Current Changes 

 
About the Interface for Consolidators Appendix 
 
This appendix contains the additional tags that are used for consolidator label functionality. These additional tags are to 
be added to the Printing XML syntax in the Endicia XML Client Interface document.  
 
Important! This document only applies to the Windows version (DAZzle). 
 
Current Changes 
 
This section describes current changes to the Endicia XML interface addendum for the consolidator. For information 
about changes to previous releases, see the Change History.  
 
Version 13.2 contains the following changes: 

 Added CONSINTL value to MailClass element of the XML Client Printing Elements. 
 
Printing 
 
Printing of a single item or a list of items can be accomplished with appropriately formatted XML data (using either a file 
or the Clipboard).  
 
When printing consolidator labels, the layout being used in DAZzle must be saved with postage printing disabled. To do 
this: 

1. Open the layout in DAZzle. 
2. Click the Postage Options button.  
3. On the Postage Options dialog Rate tab, clear the Print Postage check box.  
4. Click OK and then click the Save button. 

 
Client Printing XML Syntax—Additional Syntax for Consolidator Label Support 
 
The following table: 

 Shows the additional Client Printing XML tags for Consolidator label support in the XML Printing Elements table. 
 Applies only to Windows. 

 

XML Client Printing Elements 

Element Type Size or Value Description 
DAZzle Root - The root node for the XML request. 
 Package Node - Package information 
 MailClass Text DHLGMSMPARCELPLUSEXPEDITED 

 
DHLGMSMBPMEXPEDITED  
 
DHLGMSMBPMGROUND  
 
DHLGMSMCATALOGBPMEXPEDITED  
 

DHL Global Mail Standard Mail Parcel Plus 
Expedited (DHL only) 
DHL Global Mail Standard Mail Bound Printed 
Matter Expedited (DHL only)  
DHL Global Mail Standard Mail Bound Printed 
Matter Ground (DHL only) 
DHL Global Mail Standard Mail Catalog Bound 
Printed Matter Expedited (DHL only)  
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Element Type Size or Value Description 
DHLGMSMCATALOGBPMGROUND  
 
DHLGMSMMARKETINGPARCELEXPEDITED 
 
DHLGMSMMARKETINGPARCELGROUND 
 
DHLGMSMMEDIAMAILGROUND 
 
DHLGMSMPARCELSEXPEDITED  
 
DHLGMSMPARCELSGROUND 
 
DHLGMSMPARCELPLUSGROUND 
 
DHLGMSMPRIORITYMAIL  
 
DHLGMSMFIRSTCLASSPRODUCT  
 
DHLGMSMFIRSTCLASSPARCELS  
 
PARCELSELECT  
 
STANDARDMAILMARKETING  
 
LIBRARYMAIL  
 
MEDIAMAIL  
 
BOUNDPRINTEDMATTER 
 
IPA 
 
ISAL 
 
CONSINTL 

DHL Global Mail Standard Mail Catalog Bound 
Printed Matter Ground (DHL only)  
DHL Global Mail Standard Mail Marketing Parcel 
Expedited (DHL only) 
DHL Global Mail Standard Mail Marketing Parcel 
Ground (DHL only) 
DHL Global Mail Standard Mail Medial Mail 
Ground (DHL only) 
DHL Global Mail Standard Mail Parcels Expedited 
(DHL only)  
DHL Global Mail Standard Mail Parcels Ground 
(DHL only)  
DHL Global Mail Standard Mail Parcel Plus 
Ground (DHL only)  
Priority Mail® (DHL only)  
 
First Class Product (DHL only)  
 
First Class Parcels (DHL only)  
 
Parcel Select (non-DHL only)  
 
Standard Mail Marketing (non-DHL only) 
 
Library Mail (non-DHL only)  
 
Media Mail (non-DHL only)  
 
Bound Printed Matter (non-DHL only) 
 
International Priority Airmail M-Bags 
 
International Surface Air Lift M-Bags 
 
Generic integrated customs form for non-USPS 
use 

 IsConsolidatorLabel Text TRUE 
 
FALSE 

Indicate if the label is consolidator label. Applies 
only to consolidator accounts. Default is FALSE. 

 
Syntax Sample of a Printing XML File  
The following listing shows a syntax sample of a Printing XML file.  
 
Note: These examples will work on only DAZzle. 
 

Listing C-1 Sample Printing XML 

<DAZzle Layout="C:\Users\Public\Documents\Endicia\DAZzle\Zebra Label.lyt" 
OutputFile='C:\DAZZLE sample.XML' Start='PRINTING' Test='NO' Prompt='YES' AutoClose='NO' 
PartnerID=’A1B2’> 
 <Package ID='1'> 
  <MailClass>DHLGMSMPARCELSGROUND</MailClass> 
  <IsConsolidatorLabel>TRUE</IsConsolidatorLabel> 
  <PackageType>RECTPARCEL</PackageType> 
  <OversizeRate>FALSE</OversizeRate> 
  <WeightOz>5</WeightOz> 
  <Width>5</Width> 
  <Length>12.0</Length> 



 

CONFIDENTIAL Endicia Page 38 

  <Depth>5.5</Depth> 
  <Services CertifiedMail="OFF" USPSTracking="ON"> 
  </Services> 
  <Value>27.00</Value> 
  <ToName>Mrs. Sample Name</ToName> 
  <ToAddress1>278 Castro St</ToAddress1> 
  <ToCity>Mountain View</ToCity> 
  <ToState>CA</ToState> 
  <ToPostalCode>94041</ToPostalCode> 
  <ToEMail>SampleName@notreal.org</ToEMail> 
 </Package> 
</DAZzle> 
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Appendix D. Change History 

Version 19.1 
Excludes EFM as this version only applies to DAZzle w. SWS/IM. 
 
New or Modified Tags, Values, or Options 
 The following table shows new or modified tags, values, or options. 
  

Element Type Size or Values Description 
TransactionID Numeric 0 - 99,999 Unique ID for transaction.  Output only. 
PrintID Numeric 0 - 4,294,967,295 Unique ID for transaction in Endicia system.  

Output only.  

Version 16.1 
The following changes have been made to the Endicia XML interface: 

 New Features 
 New or Modified Tags, Values, or Options 
 Deprecated or Removed Tags, Values, or Options 

 
New Features 

 Added support for new county code BQ: Bonaire, Sint Eustatius and Saba. 
 Added support for new integrated customs form.  

 
New or Modified Tags, Values, or Options 
The following table shows new or modified tags, values, or options. 
 

Element Type Size or Values Description 
MailClass Value RETAILGROUND New name for STANDARDPOST. 
ToName Text 50 Size limited to 50 characters  
ToTitle Text 50 Size limited to 50 characters 
ToCompany Text 50 Size limited to 50 characters 
ToAddress1 Text 50 Size limited to 50 characters 
ToAddress2 Text 50 Size limited to 50 characters 
ToAddress3 Text 50 Size limited to 50 characters 
ToAddress4 Text 50 Size limited to 50 characters 
ToAddress5 Text 50 Size limited to 50 characters 
ToAddress6 Text 50 Size limited to 50 characters 

 
Deprecatedor Removed Tags, Values, or Options 
The following table shows deprecated tags, values, or options. 
 

Element Type Size or Values Description 
MailClass Arrtibute PRESORTEDFIRST 

 
STANDARDPOST  
 
 
CRITICALMAIL 

Removed. Not supported by USPS any more. 
 
Standard Post (formerly Parcel Post) 
(Deprecated. Was removed from XML in the 
January 2017 version) 
Removed. Not supported by USPS any more. 

PackageType  FLATRATEBOX 
 
 
 
REGIONALRATEBOXC 

Priority Mail Express Flat Rate Box and Priority 
Mail Medium Flat Rate Box. (Deprecated. Was 
removed from XML in the January 2017 
version). 
Removed. Not supported by USPS any more. 
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Element Type Size or Values Description 
CustomsFormType Text  

CN22 
 
CP72 

 
CN22 is the same as PS Form 2976. 
 
CP72 is the same as PS Form 2976-A. 
 
(Deprecated. Endicia software will pick the 
correct form type based on shipment 
parameters entered. Values in this element will 
be ignored. This element was removed from 
XML in the April 2016 version.) 

Version 15.2 
The following changes have been made to the Endicia XML interface: 

 New Features 
 New or Modified Tags, Values, or Options 

 
New Features 
 

 Special Contents declaration 
On May 31, 2015, the USPS is including additional items to be declared and electronically uploaded at the time 
of creating a shipping label. Any shipments that contain these contents can now be marked with the 
corresponding values in this tag. 

 
New or Modified Tags, Values, or Options 
The following table shows new or modified tags, values, or options in the XML Printing Elements table: 

 The USPSTracking tag and eDelCon tag will be ignored for mail classes for which the service is free. 
 Canada-bound shipments will now require a valid Postal Code. 

 
 

Element Type Size or Values Description 
  USPSTracking Attribute ON 

 
 
OFF 

USPS Tracking or Electronic Delivery 
Confirmation International (eDelCon) has 
been requested. 
USPS Tracking not requested 
 
For mail classes where USPS Tracking or 
eDelCon is free, this tag will be ignored. 

SpecialContents  Text  
 
 
Perishable 
 
Fragile 

Some mailable item types that require Special 
Handling must be declared. 
 
Perishable items 
 
Fragile items. 

  ToPostalCode 
 

Text 15 Destination postal code.  
 
For domestic shipments, the format is either 
ZIP5 only or ZIP+4. 
 
For Canada shipments, a Postal Code is 
required in the following format: six 
characters with no spaces and all capitals in 
the alternating letter-number format 
“A1A1A1”. 
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Version 14.1 
The following changes have been made to the Endicia XML interface: 

 New Features 
 New or Modified Tags, Values, or Options 
 Deprecated Tags, Values, or Options 
 Removed Tags, Values, or Options 

 
New Features 
 

 Priority Mail Express 10:30 Delivery 
On January 26, 2014 the USPS is adding a new option for Priority Mail Express for 10:30 A.M. delivery. This 
version of XML includes a new tag in the PriorityMailExpressDeliveryOptions node to request this option. 

 Special Contents declaration 
On January 26, 2014 the USPS is requiring that certain mailable items be declared and that information to be 
electronically uploaded at the time of creating a shipping label. Any shipments that contain these contents must 
include the appropriate values in this tag. Note that Day-old poultry may include a surcharge included in the 
postage amount. 

 
New or Modified Tags, Values, or Options 
The following table shows new or modified tags, values, or options in the XML Printing Elements table: 

 The USPSTracking tag has been added and replaces the DeliveryConfirmation tag. 
 The ToCarrierRoute tag has been modified, It is now a required when address verification is suppressed. If no 

value is enteres in the request and address verification is supressed, there will be no carrier route code printed 
on the label. 

 The SpecialContents tag has been added . 
 The PriorityMailExpress1030 tag has been added to the PriorityMailExpressDeliveryOptions node. 

 
Element Type Size or Values Description 

  USPSTracking Attribute ON 
 
 
OFF 

USPS Tracking or Electronic Delivery 
Confirmation International (eDelCon) has 
been requested. 
USPS Tracking not requested 
 

ToCarrierRoute Text 5 Carrier route code (CRC) for destination 
address. 
If address verification is suppressed you must 
include the CRC here for it to have it uploaded 
to USPS and print on label. 

SpecialContents Text  
LiveAnimals 
 
LiveAnimalsDayOldPoultry 
 
HazMat 
 
CrematedRemains 

Some mailable item types must be declared. 
Live animals. Do not use for day-old poultry. 
 
Day-old poultry. 
 
Hazardous materials. 
 
Human or animal cremated remains. 

 PriorityMailExpress1030 Attribute TRUE 
 
FALSE 

Use TRUE to indicate Priority Mail Express 
10:30 A.M. delivery has been requested.  

 
Deprecated Tags, Values, or Options 
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The following tags, values, or options have been deprecated and usage is not supported. These should be removed from 
XML requests and may be removed from the XML syntax in the future. 

 The AutoPrintCustomsForms tag has been deprecated and will be removed from XML in the January 2015 
version. 

 The USPS has renamed domestic Delivery Confirmation to USPS Tracking. Therefore a new USPSTracking tag is 
replacing this tag. However, this tag will continue to be valid until further notice. If the USPSTracking tag is used, 
it will override the DeliveryConfirmation tag 

 The EXPRESS and INTLEXPRESS values of the MailClass tag have been deprecated and will be removed from XML 
in the January 2015 version. 

 The ExpressMailDeliveryOptions tag has been deprecated and will be removed from XML in the January 2015 
version. 

 
Element Type Size or Values Description 

 AutoPrintCustomsForms 
 

attribute YES 
 
NO 

A value of YES causes DAZzle to print any 
requested customs form to the default 
Windows printer. 
 
 (Deprecated. Was removed from XML in the 
January 2015 version.) 

 DeliveryConfirmation  Attribute ON 
 
 
OFF 

USPS Tracking has been requested. This also 
applies to International E-Delivery 
Confirmation (eDelCon) 
USPS Tracking has not been requested. 
(Deprecated. The USPS has renamed 
domestic Delivery Confirmation to USPS 
Tracking. Therefore a new USPSTracking tag is 
replacing this tag. However, this tag will 
continue to be valid until further notice. If the 
USPSTracking tag is used, it will override the 
DeliveryConfirmation tag.) 

MailClass Text EXPRESS 
 
INTLEXPRESS 

Express Mail® (Deprecated. Will be removed 
from XML in the January 2015 version.) 
Express Mail International® (Deprecated. Will 
be removed from XML in the January 2015 
version.) 

ExpressMailDeliveryOptions Node n/a Delivery options for Priority Mail Express. 
Note: This node is replacing the node 
<ExpressMailDeliveryOptions>, which has 
been deprecated and will be removed from 
XML in the January 2015 version. 

 
Removed Tags, Values, or Options 
 
The following tags, values, or options have been removed from the XML Printing Elements table and will either be 
ignored or may cause errors if used. These must be removed from XML requests. 

 The SignatureWaiver tag has been removed and replaced by the SignatureRequired tag within the 
PriorityMailExpressDeliveryOptions node. 

 The ExpressMailPremiumService tag has been removed and replaced by two tags that may be used individually 
or together: SundayDelivery and HolidayDelivery. These new tags are within the 
PriorityMailExpressDeliveryOptions node. 

 The NoWeekendDelivery tag has been removed and replaced by two tags: SaturdayDelivery and SundayDelivery. 
These new tags are within the PriorityMailExpressDeliveryOptions node. 

 The NoHolidayDelivery has been removed and replaced by the HolidayDelivery tag within the 
PriorityMailExpressDeliveryOptions node. 



 

CONFIDENTIAL Endicia Page 43 

 The PARCELPOST value of the MailClass tag has removed and replaced by the STANDARDPOST value. 
 The ReturnToSender tag has been removed. Functionality is being replaced by the IfNonDeliverable tag in the 

International node. 
 The ContentsTypeOther tag has been removed and functionality has been replaced by the ContentsType tag. 

Element Type Size or Values Description 
  SignatureWaiver Text TRUE 

FALSE 
For Express Mail, indicates if the signature 
requirement can be waived. Use TRUE to allow 
waiver of signature. 

ExpressMailPremium 
Service 

Text TRUE 
FALSE 

Enable Premium Service (Sunday/Holiday Delivery) 
for Express Mail–ONLY applies when Mail Class is 
Express Mail 
Turn off Premium Service. 

NoWeekendDelivery Text TRUE 
FALSE 

For Express Mail, use TRUE to request NO delivery 
on a weekend. 

NoHolidayDelivery Text TRUE 
FALSE 

For Express Mail, use TRUE to request NO delivery 
on a holiday. 

MailClass Text PARCELPOST Parcel Post Mail Class. 
ReturnToSender Text TRUE 

 
FALSE 

For Priority Mail Express International, use TRUE to 
indicate item should be returned to sender if 
undeliverable. Currently this MUST be TRUE. 

ContentsTypeOther Text 25 Text that can be entered to specify the Other 
category. 

Version 13.5 
The following changes have been made to the Endicia XML interface: 
 
Additional and Modified Values 
 
The following table shows additional or modified values in the XML Printing Elements table: 

Element Type Size or Values Description 
  PackageType Text REGIONALRATEBOXA 

 
REGIONALRATEBOXB 
 
REGIONALRATEBOXC 

Regional Rate Box A–Priority Mail 
 
Regional Rate Box B–Priority Mail 
 
Regional Rate Box C–Priority Mail 

  MailClass Text DHLGMSMMARKETINGPARCELEXP
EDITED 
DHLGMSMMARKETINGPARCELGR
OUND 

DHL Global Mail Standard Mail Marketing 
Parcel Expedited (DHL only) 
DHL Global Mail Standard Mail Marketing 
Parcel Ground (DHL only) 

 

Version 13.4 
There are no XML changes in version 13.4. 

Version 13.3 
The following changes have been made to the Endicia XML interface: 
 
Additional, Modified, and Deprecated Values 
 
The following table shows additional or modified values in the XML Printing Elements table: 

Element Type Size or Values Description 
  MailClass Text PRIORITYEXPRESS 

 
Priority Mail Express® (formerly Express 
Mail®) 
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Element Type Size or Values Description 
EXPRESS 
 
INTLPRIORITYEXPRESS 
 
INTLEXPRESS 
 

Express Mail® (Deprecated. Was removed 
from XML in the January 2015 version) 
Priority Mail Express International® (formerly 
Express Mail International®) 
Express Mail International® (Deprecated. Was 
removed from XML in the January 2015 
version) 

  PriorityMailExpressDeliveryO
ptions 

Node  Delivery options for Priority Mail Express. 
Note: This node replaced the node 
<ExpressMailDeliveryOptions>, which was 
deprecated and removed from XML in the 
January 2015 version. 

 AutoPrintCustomsForms 
 

attribute YES 
 
NO 

A value of YES causes DAZzle to print any 
requested customs form to the default 
Windows printer. 
 
 (Deprecated. Was removed from XML in the 
January 2015 version) 

 

Version 13.2 
The following changes have been made to the Endicia XML interface: 
 
Additional or Modified Values 
 
The following table shows the additional or modified values in the XML Printing Elements table: 

Element Type Size or Value Description 
 MailClass Text CONSINTL Generic CN22 for non-USPS use 
 PostageBalance Curre

ncy 
99,999.99 Postage balance remaining in 

account. Output only. 
 

Version 13.1 
The following changes have been made to the Endicia XML interface: 

 New Features 
 Additional or Modified Values 
 New Tags or Options 
 Deprecated Tags or Options 
 Removed Tags or Options 

 
New Features 
 

 Standard Post mail class 
 First-Class Package International Service™ mail class 
 E-Delivery Confirmation service 
 Critical Mail with Signature Service 

 
Additional or Modified Values 
 
The following table shows the additional or modified values in the XML Printing Elements table: 

Element Type Size or Value Description 
ContentsType Text 60 Validation has been removed from this 

element. Any text can be entered. 
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Element Type Size or Value Description 
MailClass Text STANDARDPOST Standard Post (formerly known as Parcel 

Post) 
 
New Tags or Options 
The following table shows new tags or options in the XML Printing Elements table: 

Element Type Size or Values Description 
  LicenseNo Text 20 Conditionally used only if CP72 is the value set for 

CustomsFormType. 
License number. 

  CertificateNo Text 20 Conditionally used only if CP72 is the value set for 
CustomsFormType. 
Certificate number. 

  InvoiceNo Text 20 Conditionally used only if CP72 is the value set for 
CustomsFormType. 
Invoice number. 

  Comments Text 80 Conditionally used only if CP72 is the value set for 
CustomsFormType. 
Identify if special conditions or restrictions apply to items 
being mailed. For example, if the contents are subject to 
quarantine restrictions. 

  SendersCustomsReference Text 30 Conditionally used only if CP72 is the value set for 
CustomsFormType. 

Sender’s customs reference. 
  ImportersCustomsReference Text 30 Conditionally used only if CP72 is the value set for 

CustomsFormType. 
Importer’s customs reference (might be a tax code, 
importer code, or VAT number used for sales tax). 

  AesItnExemption Text 20 Conditionally used only if CN22 or CP72 is the value set for 
CustomsFormType. 
Except for shipments to APO/FPO/DPO addresses, enter an 
Automated Export System (AES) Internal Transaction 
Number (ITN), AES Exemption, or if applicable, an AES 
Downtime Citation. 
Default value: NOEEI 30.37(a) 

  ReturnAddressPhone Text  Telephone associated with return address (used for 
Customs form)  
Must include at least one number. 

  ReturnAddressEmail Text  Email address associated with return address (used for 
Customs form) 

Deprecated Tags or Options 
 
The following tags or options have been deprecated and usage is not supported. These tags or options should be 
removed from XML requests and may be removed from the XML syntax in the future. 

 The PARCELPOST value of the MailClass tag has been deprecated and will be removed from XML in the Jan 2014 
version. 

 The ReturnToSender tag has been deprecated and will be removed from XML in the January 2014 version. 
Functionality is being replaced by and will be overridden by the IfNonDeliverable tag in the International node. 

 
Removed Tags or Options 
 
The following tags or options have been removed from the XML Printing Elements table and will either be ignored or 
may cause errors if used. These tags or options must be removed from XML requests. 

 SignatureWaiver 
 ExpressMailPremiumService 
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 NoWeekendDelivery 
 NoHolidayDelivery 
 ShowPostageAndFees 

Version 12.4 
The following changes have been made to the Endicia XML interface with version 12.4: 

 New Features 
 New Tags or Options 

 
New Features 
 

 Increase maximum number of customs form commodity line items . 
 Return receipt endorsement flag . 
 Set default non-deliverable option as "Return to sender". 

 
New Tags or Options 
The following table shows new tags or options in the XML Printing Elements table in version 12.4: 

 Added the new tag ReturnReceiptEndorsement with the following values 
o ON 
o OFF 

 

New Tags or Options in Version 12.4 

Element Type Size or Values Description 
ReturnReceiptEndorsement Attribute ON 

 
OFF 

Return Receipt endorsement is printed on the 
label. 
Return Receipt endorsement is not printed on 
the label. 
Default value is OFF. 

 

Version 12.3 
The following changes have been made to the Endicia XML interface with version 12.3: 

 New Features 
 New Tags or Options 
 Deprecated Tags or Options 

 
New Features 
 
The following new features were added: 

 International non-delivery options 
 Express Mail Padded Flat Rate Envelope 
 Show or Hide Postage and Fees on customs form 

 
New Tags or Options 
The following table shows new tags or options in the XML Printing Elements table in version 12.3: 

 Added the new node International with the following attributes: 
o IfNonDeliverable with the following values: 

 Forward 
 Return 
 Abandon 

o Address1 
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o Address2 
o Address3 
o Address4 

 Added the new tag ShowPostageAndFees with the following values: 
o TRUE 
o FALSE 

 

New Tags or Options in Version 12.3 

Element Type Size or Values Description 
  International Node  International options 

 IfNonDeliverable Attribute  
Abandon 
 
Return 
 
Forward 

Instructions if non-deliverable (CP72 only) 
Treat as abandoned 
 
Return to sender 
 
Redirect to alternate address 

 Address1 Attribute 36 Redirect address (Forward only) 
 Address2 Attribute 36 Redirect address (Forward only) 
 Address3 Attribute 36 Redirect address (Forward only) 
 Address4 Attribute 36 Redirect address (Forward only) 

  ShowPostageAndFees Text TRUE 
FALSE 

TRUE means the postage will be printed in box to 
the left of the round stamp. This is independent of 
the Stealth tag.Postage amount may be needed for 
the destination country customs agency and may 
cause customs delays if not shown on label. 
Applies to Large CP72 customs form only. 
Default value is TRUE. 

 
Deprecated Tags or Options 
 
The following deprecated tags or options XML Printing Elements table will not be supported: 

 ExpressMailOptions 

Version 12.2 
The following changes have been made to the Endicia XML interface with version 12.0 : 

 Additional Values 
 Deprecated Tags or Options 

 
Additional Values 
 
The following table shows the additional values for PackageType element of the XML Printing Elements table: 

Element Type Size or Value Description 
PackageType Text HALFTRAYBOX For use with Priority Mail Open and 

Distribute (PMOD) (Domestic only) 
PackageType Text FULLTRAYBOX For use with PMOD (Domestic only) 

 
PackageType Text EMMTRAYBOX For use with PMOD (Domestic only) 

 
PackageType Text FLATTUBTRAYBOX For use with PMOD (Domestic only) 

 
PackageType Text SACK For use with PMOD and EMOD (Domestic 

only) 
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Deprecated Tags or Options 
 
The following deprecated tags or options XML Printing Elements table will not be supported: 

 ExpressMailOptions 
 

Version 12.0 
The following changes have been made to the Endicia XML interface with version 12.0: 

 New Features 
 Additional Values 
 New Tags or Options 
 Deprecated Tags or Options 

 
New Features 
 
The following new features were added: 

 Express Mail Flat Rate Box 
 New Regional Rate Box C 
 Cubic Soft Pack 
 Express Mail Delivery Options 
 First-Class Package Service 

 
Additional Values 
 
The following table shows the additional values for PackageType element of the XML Printing Elements table: 

Element Type Size or Value Description 
PackageType Text FLATRATEMEDIUMBOX Synonymous with FLATRATEBOX 

 
PackageType Text REGIONALRATEBOXC Regional Rate Box C–Priority Mail (Domestic 

only) 
 
New Tags or Options 
The following table shows new tags or options in the XML Printing Elements table in version 12.0: 

 Added the new CubicIndicator element with the following values: 
o RECTANGULAR 
o SOFTPACK 

 Added the new node ExpressMailDeliveryOptions with the following elements and values: 
o Added the following values to the new SignatureRequired element: 

 TRUE 
 FALSE 

o Added the following values to the new SaturdayDelivery element: 
 TRUE 
 FALSE 

o Added the following values to the new SundayDelivery element: 
 TRUE 
 FALSE 

o Added the following values to the new HolidayDelivery element: 
 TRUE 
 FALSE 

 Added the new RetailIndicator element with the following values: 
o TRUE 
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o FALSE 
 

New Tags or Options in Version 12.0 

Tag Value Description 
PackageType FLATRATEMEDIUMBOX Synonymous with FLATRATEBOX 
PackageType REGIONALRATEBOXC Regional Rate Box C–Priority Mail (Domestic only) 
CubicIndicator  

RECTANGULAR 
 
 
SOFTPACK 

Applicable only for Priority Mail Parcel.  
Used for traditional cubic pricing for Rectangular and 
Nonrectangular Parcels in which Length, Width, and 
Height are considered. (Default value) 
Used for cubic Soft Pack and Padded Envelopes in 
which only length and width are considered. 

ExpressMailDeliveryOptions — Delivery options for Express Mail 
 SignatureRequired TRUE 

FALSE 
Use TRUE to Indicate signature is required upon 
delivery 

 SaturdayDelivery TRUE 
FALSE 

Use TRUE to indicate Saturday delivery requested. 
Default value is TRUE. 

 SundayDelivery TRUE 
FALSE 

Use TRUE to indicate Sunday delivery requested. 

 HolidayDelivery TRUE 
FALSE 

Use TRUE to indicate holiday delivery requested. 

RetailIndicator TRUE 
FALSE 

For First-Class parcel shipments, use TRUE to force 
the use of retail pricing when postal rules require 
such classification. It is ignored for any other mail 
class and package type combinations. 

 
Deprecated Tags or Options 
 
After January 2013, the following deprecated tags or options XML Printing Elements table will not be supported: 

 SignatureWaiver 
 ExpressMailPremiumService 
 NoWeekendDelivery 
 NoHolidayDelivery 

 

Version 11.5 
There are no XML changes in this release of DAZzle. 

Version 11.4 
The following changes have been made to the Endicia XML interface with version 11.4: 

 New Tags or Options 
 
New Tags or Options 
The following table shows new tags or options in the XML Printing Elements table in version 11.4: 

 Added the following attributes to the Services element of XML Printing Elements: 
o AdultSignatureRequired 
o AdultSignatureRestricted 

 Added the following attribute to the PackageType element of XML Printing Elements table: 
o FLATRATELARGEBOARDGAMEBOX 

 

New Tags or Options in Version 11.4 
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Tag Value Description 
Services AdultSignatureRequired For Adult Signature Required requested, use ON. 

 
For Adult Signature Required not requested, use OFF. 

Services AdultSignatureRestricted For Adult Signature Restricted requested, use ON. 
 
For Adult Signature Restricted not requested, use OFF. 

PackageType FLATRATELARGEBOARDGAMEBOX Flat Rate Large Board Game Box–Priority Mail (Domestic and 
International) 

 

Version 11.3 
The following changes have been made to the Endicia XML interface with version 11.3: 

 New Tags or Options 
 
New Tags or Options 
The following table shows new tags or options to the DAZzle element of XML Printing Elements in version 11.3. 

 Added the PartnerID attribute. 
 Added the OpenAndDistribute attribute. 
 Added the MailClassEnclosed attribute. 

 

New Tags or Options in Version 11.3 

Tag Value Description 
DAZzle PartnerID Specify the Partner ID assigned by Endicia. 

 
DAZzle OpenAndDistribute For Express Mail or Priority Mail, use TRUE to specify an OpenAndDistribute label. 

Defaults to FALSE. 
DAZzle MailClassEnclosed Type of mail class enclosed. No validation. Some valid values: Standard Mail Letters, 

Standard Mail Flats, Standard Mail Parcels, or specify other value. Required when 
OpenAndDistribute is TRUE. 

 

Version 11.2 
The following changes have been made to the Endicia XML interface with version 11.2: 

 New Tags or Options 
 
New Tags or Options 
The following table shows new tags or options in the XML Printing Elements table in version 11.2. 
 

 Added FLATRATEDVDBOX and FLATRATELARGEVIDEOBOX values to the PackageType element of XML Printing 
Elements. 

New Tags or Options in Version 11.2 

Tag Value Description 
PackageType FLATRATEDVDBOX Flat Rate DVD Box–Priority Mail International only 

 
PackageType FLATRATELARGEVIDEOBOX Flat Rate Large Video Box–Prioritiy Mail International Only 
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Version 11.1 
The following changes have been made to the Endicia XML interface with version 11.1: 
 

 Additional Values  
 New Tags or Options 

 
Additional Values 
 
The following table shows the additional value for MailClass element of the XML Printing Elements table: 

Tag Type Value Description 
MailClass Text CRITICALMAIL Critical Mail—Only available to qualified 

Commercial Plus customers. PackageType 
has to be LETTER or FLAT. 

 
The following table shows additional values for PackageType element of the XML Printing Elements table: 
 

Tag Type Value Description 
PackageType Text FLATRATELEGALENVELOPE 

 
 
REGIONALRATEBOXA 
 
 
REGIONALRATEBOXB 
 
 
FLATRATEGIFTCARDNVELOP
E 
 
FLATRATEWINDOWENVELO
PE 
 
FLATRATECARDBOARDENVE
LOPE 
 
SMALLFLATRATEENVELOPE 
 

Flat Rate Legal Envelope—Priority Mail and 
Express Mail (Domestic only) 
 
Regional Rate Box A—Priority Mail 
(Domestic only) 
 
Regional Rate Box B—Priority Mail 
(Domestic only) 
 
Flat Rate Giftcard Envelope–Priority Mail 
and Express Mail (Domestic only) 
 
Flat Rate Window Envelope–Priority Mail 
and Express Mail (Domestic only) 
 
Flat Rate Cardboard Envelope–Priority Mail 
and Express Mail (Domestic only) 
 
Small Flat Rate Envelope–Priority Mail and 
Express Mail (Domestic only) 
 

 
Changed Descriptions 
The following table shows changed descriptions for PackageType element of the XML Printing Elements table: 
 

Tag Type Size or Value Description 
PackageType Text FLATRATEPADDEDENVELOP

E 
 

Flat Rate Padded Envelope–Priority Mail  
 

 
New Tags or Options 
The following table shows new tags or options in the Services element of the XML Printing Elements table: 
 

Tag Type Size or Value Description 
HoldForPickup Text TRUE 

FALSE 
For Express Mail, Priority Mail, First Class 
Mail, Parcel Select, use TRUE to indicate Hold 
For Pickup requested. 
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Tag Type Size or Value Description 
HFPFacilityID Text 20 Facility ID of the Post Office that will hold the 

item for pickup. 
HFPFacilityName Text 150 Facility name of the Post Office that will hold 

the item for pickup. 
HFPFacilityAddress Text 150 Facility address of the Post Office that will 

hold the item for pickup. 
HFPFacilityCity Text 50 City of the Post Office that will hold the item 

for pickup. 
HFPFacilityState Text 25 State of the Post Office that will hold the item 

for pickup. 
HFPFacilityZip5 Text 5 5 digit ZIP Code of the Post Office that will 

hold the item for pickup. 
HFPFacilityZip4 Text 4 +4 add-on ZIP Code of the Post Office that will 

hold the item for pickup. 
 
 

Version 10.3 
The following changes have been made to the Endicia XML interface with version 10.1: 

 Additional value for status tags. 
 
Additional Value for Status Tags 
The following table shows an additional value for the status tags: 
 

Value Description 
-12 Invalid feature for account. 

 

Version 10.1 
The following changes have been made to the Endicia XML interface with version 10.1: 
 

 New Tags or Options 
 
New Tags or Options 
The following table shows new tags or options in the XML Printing Elements table in version 10.1. 

New Tags or Options in Version 10.1 

Tag Type Size or Value Description 
CustomsQuantityN Numeric 8 "N" can be any integer from 1 through 30. Quantity of the "Nth" 

item in customs declaration.  

For Windows only. 
CustomsDescriptionN Text 50 Description of the "Nth" item in the customs declaration.  

For Windows only. 
CustomsWeightN Numeric 8 Weight of the "Nth" item in customs declaration–in ounces. 
CustomsValueN Currency 99,999.99 Value of the "Nth" item in the customs declaration.  

For Windows only. 
CustomsCountryN Text 25 Country of Origin for the "Nth" item in the customs declaration. 

This MUST be a valid, USPS recognized country.  



 

CONFIDENTIAL Endicia Page 53 

For Windows only. 
CustomsHTSN Numeric 10 "N" can be any integer from 1 through 30. Harmonized Tariff 

Schedule (HTS) ID for the "Nth" item in customs declaration.  

For Windows only. 
 
Documentation Correction 
On May 24, 2010, corrected a typographical error—a missing space: 
Was:  
<ServicesCertifiedMail="OFF" DeliveryConfirmation="ON" ></Services>  
Corrected to: 
<Services CertifiedMail="OFF" DeliveryConfirmation="ON" ></Services>  
 

Version 10.0 
With the January 2010 US Postal Service price change or enhancements, the following fully backward compatible 
changes have been made to the XML interface with version 10.0:  
 

 New Tags or Options 
 
New Tags or Options 
The following table shows new tags or options in version 10.0. 

New Tags or Options in Version 10.0 

Tag Value Description 
PackageType FLATRATEPADDEDENVELOPE Flat Rate Padded Envelope–

Qualified Commercial Plus 
Pricing Priority Mail (Domestic 
only) 

MailClass PARCELSELECT Parcel Select®. Delivery 
Confirmation or Signature 
Confirmation is required. 

Status -5 Unsupported domestic mail 
options (Windows only) 

 

Version 9.1 
This document includes a new chapter, Vista and Windows 7 Compatible Installation and Updates, the registry entries 
that make DAZzle data compatible with Microsoft Vista and Windows 7. 
 
This new chapter is organized by new or “fresh” installations of DAZzle and upgrades from previous installations of 
DAZzle. 
 

Version 9.0 
With the January 2009 US Postal Service price change or enhancements, the following fully backward compatible 
changes have been made to the XML interface with version 9.0:  
 
• New Tags or Options 
 
New Tags or Options 
The following table shows new tags or options in version 9.0. 
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New Tags or Options in Version 9.0 

Tag Value Description 
PackageType FLATRATESMALLBOX Flat Rate Small Box–Priority Mail 

(Domestic and International) 
Status -11 Express Mail International®, 

Priority Mail International®, or 
First-Class Mail International® 
Error–no “to phone” for mail 
addressed to P. O. Boxes. 

 

Version 8.1.06 
There are no changes to XML interface for the 8.1.06 release, however, effective September 12, 2008, the USPS requires 
a permit to print postage for Bound Printed Matter (BPM). As a result, you must update any DAZzle configurations that 
use BPM.  
 

Version 8.1 
There are no XML interface element changes with release 8.1 of DAZzle. However, the USPS has changed some of the 
mailing rules that may require the additional use of existing tags. First-Class Mail International is “shape based” starting 
May 12, 2008, so the shape or dimension information for each FCMI package should be supplied in the XML (the same as 
domestic First-Class Mail). 
 

Version 8.0 
With the March 2008 US Postal Service rate enhancements, there are some minor changes to the Endicia XML interface 
with version 8.0.  
The following (fully backward compatible) changes have been made to the XML interface: 
• New Tags or Options 
• Output Changes 
 

New Tags or Options 
The following table shows new tags or options in version 8.0. 

Table 8—New Tags or Options in Version 8.0 

Tag Value Description 
PackageType FLATRATELARGEBOX Large Flat Rate Box–Priority Mail 

(Domestic and International) 
ExpressMailPremiumService TRUE (or YES or ON) 

 
 
 
FALSE (or NO or OFF) 

Enable Premium Service 
(Sunday/Holiday Delivery) for 
Express Mail–ONLY applies when 
Mail Class is Express Mail  
Turn off Premium Service 

 

Output Changes 
With the addition of support for the USPS Confirm® tracking system in DAZzle 8.0, the CONFIRM tracking number is 
output in the “PIC” output tag (where DC and Express Mail tracking numbers are the output) when printing with that 
option enabled.  
Note: Because the use of CONFIRM is configured as part of a layout, there is no option to turn CONFIRM on or off 
through XML. Choose a layout that is preconfigured with CONFIRM enabled. 
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Version 7.0 
Due to the May 2007 US Postal Service rate changes, there are significant changes to the Endicia XML interface with 
version 7.0. A number of new tags were added to support new mail classes, some tags have become obsolete and most 
importantly, for backwards compatibility DAZzle contains new logic to automatically convert use of obsolete tags to the 
new tags. These assumptions may not be correct in all cases and conversion to the new tags should be made as soon as 
possible. While the “obsolete” tags will be converted to the new tags by DAZzle, the obsolete tags will be dropped in 
version 7.1 of DAZzle. 
 

Important! Do NOT use version 7.0 XML with any versions of DAZzle prior to version 7.0! Your results will be 
unpredictable. 

 
The following sections summarize the changes with version 7.0: 
 
• New tags and options 
• Obsolete tags or options 
• Backwards compatibility 
 

New tags and options 
The following table describes new tags and options in version 7.0. 

New Tags and Options in Version 7.0 

Tag Value Description 
OversizeRate TRUE  

FALSE 
TRUE means to use the oversized rate for Parcel 
Post. 

NonMachinable TRUE  
FALSE 

TRUE means use non-machinable rates. Applies to 
First-Class Mail, Parcel Post, and First-Class Mail 
International.  

BalloonRate TRUE  
FALSE 

TRUE means use the “balloon rate” for Priority 
Mail (the 20-lb. rate). Setting the weight to 20 lbs. 
has same effect. 

PackageType POSTCARD  
 
ENVELOPE  
FLAT  
 
RECTPARCEL  
NONRECTPARCEL 
 
FLATRATEENVELOPE 
 
FLATRATEBOX 

Postcard rate (First-Class Mail and First-Class Mail 
International). 
Standard “letter” rate. 
Large Envelope (Flat) rate (only effects rate for 
First-Class Mail or Bound Printed Matter). 
Rectangular Parcel–the standard parcel. 
Non-rectangular parcel–impacts rate for Priority 
Mail. 
Flat Rate Envelope–Priority Mail and Express Mail. 
Flat Rate Box–Priority Mail. 

MailClass INTLFIRST  
 
INTLEXPRESS  
INTLPRIORITY  

First-Class Mail International replaces INTLLETTER 
and INTLAIRLETTER.  
Express Mail International replaces INTLGEM. 
Priority Mail International replaces INTLGPM, 
INTLGPMFRSMALL, and INTLGPMFRLARGE. 

Width Numeric, 0.00 to 130.00 inches Width of envelope, flat, or package. Optional, but 
recommended on Priority Mail and Parcel Post for 
proper compliance with USPS regulations. 

Length Numeric, 0.00 to 130.00 inches Length of envelope, flat, or package. Optional, but 
recommended on Priority Mail and Parcel Post for 
proper compliance with USPS regulations. 

Depth Numeric, 0.00 to 130.00 inches  Depth (or thickness) of envelope, flat, or package. 
Optional, but recommended on Priority Mail and 
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Tag Value Description 
Parcel Post for proper compliance with USPS 
regulations. 

ContentsType RETURNEDGOODS New option for ContentsType tag. 
CustomsSigner Text, 50 Name of person certifying that the customs 

information is correct. This name will be printed 
on the customs form in place of a signature IF 
CustomsCertify is TRUE. 

CustomsCertify TRUE FALSE TRUE means that the customs information is 
certified to be correct and the CustomsSigner 
name should be printed. 

 

Obsolete tags or options 
The following table describes obsolete tags and options as of version 7.0. 

ObsoleteTags or Options in Version 7.0 

Tag Value Description 
MailClass POSTCARD  

INTLGEM  
INTLGPM 
INTLGPMFRSMALL 
INTLGPMFRLARGE 
INTLLETTER 
INTLAIRLETTER 
INTLAEROGRAMME 
INTLPARCEL 
INTLAIRPARCEL 
INTLPOSTCARD 

First Class Mail–replaced by new PackageType option. 
Global Express Mail–replaced by INTLEXPRESS. 
Global Priority Mail–replaced by INTLPRIORITY. 
Global Priority Mail, Small Flat Rate–obsolete class. 
Global Priority Mail, Large Flat Rate–obsolete class. 
International, Economy Letter–obsolete class. 
International, Air Letter–obsolete class. 
International, Aerogramme–obsolete class. 
International, Economy Parcel–obsolete class. 
International, Air Parcel–obsolete class. 
International Postcard–replaced by PackageType option. 

Oversize All Replaced by OversizeRate, NonMachinable, and BalloonRate. 
FlatRate All Replaced by new PackageType tag. 

All obsolete tags and options have been dropped from the full specifications in section 2. 
 

Backwards compatibility 
While some of the changes in version 7.0 are “universal” and apply equally well to the 2006 and 2007 rates, a number of 
changes do not directly apply if used with the wrong rates. To compensate for this, DAZzle applies the following “rules” 
to convert the use of tags that do not apply to the “current” rates. 
In general when a new tag has been added that replaces the functionality of an obsolete tag (for example BalloonRate 
and Oversize), and BOTH tags appear in the XML, the functionality of the new tag will override any setting of the 
obsolete tag. For example, if both Oversize and BalloonRate are used, BalloonRate will override the values for Oversize. 
When using obsolete tags when the new 2007 postage rates are in effect (basically, if “old” XML is used with no changes 
to the new tags): 
 

 Oversize=YES will result in non-machinable being TRUE if the mail class is First-Class (both domestic and 
international) or Parcel Post. 

 Oversize=YES will result in Balloon Rate being TRUE if the mail class is Priority Mail. 
 Oversize=YES and the weight = 71 lbs will result in the use oversize rate for Parcel Post. 
 FlatRate=YES is the same as PackageType=FLATRATEENVELOPE. 
 FlatRate=BOX is the same as PackageType=FLATRATEBOX. 
 MailClass=POSTCARD is converted to MailClass=FIRST and PackageType=POSTCARD. 
 MailClass=INTLAEROGRAMME is converted to MailClass=FIRST and PackageType=POSTCARD. 

(Aerogrammes have been discontinued.) 
 MailClass=INTLGEM is converted to MailClass=INTLEXPRESS. 
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 MailClass=INTLGPM is converted to MailClass=INTLPRIORITY. 
 MailClass=INTLGPMFRSMALL is converted to MailClass=INTLPRIORITY and 

PackageType=FLATRATEENVELOPE. 
 MailClass=INTLGPMFRLARGE is converted to MailClass=INTLPRIORITY and 

PackageType=FLATRATEBOX. 
 MailClass=INTLLETTER is converted to MailClass=INTLFIRST and PackageType=ENVELOPE. 
 MailClass=INTLAIRLETTER is converted to MailClass=INTLFIRST and 

PackageType=ENVELOPE. 
 MailClass=INTLAIRPARCEL is converted to MailClass=INTLPRIORITY and 

PackageType=RECTPARCEL. 
 MailClass=INTLPARCEL is converted to MailClass=INTLPRIORITY and 

PackageType=RECTPARCEL. 
When using new 7.0 (2007) rate tags while the 2006 postage rates are still in effect (you convert to the new XML format 
before May 14, 2007): 

 MailClass=INTLFIRST is converted to MailClass=INTLLETTER. 
 MailClass=INTLEXPRESS is converted to MailClass=INTLGEM. 
 MailClass=INTLPRIORITY is converted to MailClass=INTLGPM. 
 MailClass=INTLPRIORITY and PackageType=FLATRATEENVELOPE is converted to 

MailClass=INTLGPMFRSMALL. 
 MailClass=INTLPRIORITY and PackageType=FLATRATEBOX is converted to 

MailClass=INTLGPMFRLARGE. 
 Use of Width, Height, or Depth has no impact (is ignored). 
 Use of RECTPARCEL, NONRECTPARCEL, or FLAT has no impact (are ignored). 
 Use of CustomsSigner or CustomsCertify has no impact (are ignored). 

 


